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Introduction to this tutorial

iSeries” Web development tools give you the ability to create new e-business
applications that use a Web-based front end to communicate with the business
logic in an ILE or non-ILE language program residing on an iSeries server. You can
create the high-level design of your Web site and apply page templates using Web
site designer. Then, you can create the individual pages with Page Designer, or
generate input and output JSP files with the Web Interaction wizard. You can also
add iSeries Web components to your pages, for example, Web equivalents of
iSeries command keys, input fields that accept only particular types of data, or
output fields such as subfile names.

Tutorial purpose:
Before you begin, take a minute to read the learning objectives for the
tutorial.

Length of time:
This tutorial takes approximately 1.5 hours to complete.

Modules:
Work on the modules in sequence. The pictures in the modules show
similar tasks. Some of the names and icons may be different from the
environment you will be working with when you complete the modules.

Prerequisites
You should also learn about the prerequisite knowledge for the tutorial
before beginning. This section describes the type of knowledge you need to
already have to fully benefit from this tutorial.

Learning objectives

In order to successfully develop and test an e-business RPG application, you will
need to understand many concepts. This tutorial is designed to help you learn
about those concepts while working through the steps. In this tutorial, you will
create a simple e-business customer inquiry application. While creating a browser
user interface, you will learn how to use the iSeries wizards in Development
Studio Client to create the servlets to invoke an RPG program that performs the
business logic. You will then learn how to run the application in the WebSphere®
Test Environment that is part of Development Studio Client.

The tutorial is broken into seven modules, each with their own specific learning
objectives. You can choose to complete all modules, or you can choose to complete
only a few, depending on your own learning goals. Each module is composed of
several exercises. These exercises must be completed in order to successfully
achieve the module’s goals.

The first module, Introducing the Web customer inquiry application, shows you
the completed customer inquiry application that you will build in this tutorial. You
will also learn about the iSeries Web development tools that you will use to create
this Web application.

The second module, Creating a new Web project, helps you learn about the Web
perspective and the tools in this perspective to help you create a Web project to
contain your Web application files and to supply the information which the iSeries
server will use for serving business information for this Web application.
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The third module, Visually consructing the Web application explains how to create
a representation of a Web interaction in the Web diagram. You will learn how to
add JSP file nodes and an action mapping node and how to draw connections
between these nodes. You will also learn about Struts-based Web applications.

The fourth module, Creating the Web interaction, helps you learn how to create a
Web interaction to use an input and output page, and to create the servlet to
invoke an RPG program to get data from the iSeries database. While creating this
Web interaction you will also learn how to use the Web diagram that you already
created in the third module.

The fifth module, Adding the iSeries program to the Web application, you learn
how to use the Remote System Explorer perspective to edit and compile an iSeries
program or service program that will be invoked by the Web application to get
data from the iSeries.

The sixth module, Running the Web application explains how to run the Web
application in the WebSphere Test Environment. You also learn about the
WebSphere Test Environment.

The seventh module, Adding flow control, helps you learn how to create an
informative error page for customers when an incorrect customer number is
entered.

The eighth module, Enhancing the input page using Web tools, explains how to
add colour and some pictures to make the input page of the Web application more
attractive. You will learn how to use the Page Designer tool and some other related
Web tools.

Be sure to read about the Prerequisite knowledge for the tutorial before beginning.
This section describes the type of knowledge you need to already have to fully
benefit from this tutorial.

Prerequisite knowledge

vi

In order to complete this tutorial end to end, you should already have working
knowledge of the following:

* Basic Microsoft® Windows® operations such as working with the desktop and
basic mouse operations such as opening folders and performing drag-and-drop
operations.

* How Web applications work.

* How to use a browser to navigate the Internet.

It is also useful, but not necessary, for you to have basic knowledge of the
following:

* DDS

* Servlets and Java'" Server Pages (to understand the generated output of the Web
Interaction wizard)

If you do not have current knowledge of these technologies and concepts, you
might be interested in learning more about these after you complete this tutorial.
You can find some additional information on these topics in the Help system that
is part of WebSphere Development Studio Client for iSeries. There are also plenty
of resources on the Internet at our product Web page

http:/ /www.ibm.com/software/awdtools/iseries.
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When you are ready to begin, start with Module 1: Introducing the Web customer
inquiry application.
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Chapter 1. Module 1: Introducing the Web customer inquiry
application

In this module, you will be introduced to the Web customer inquiry application
that you will build in this tutorial. You will also learn about the iSeries Web tools
included with Development Studio Client.

In order to gain a introductory understanding of customer inquiry application and
the iSeries Web development tools, there are several steps you will need to learn
about and follow:

* Explain the tools available to iSeries programmers for iSeries Web application
development

* Describe the Web customer inquiry application

In order to accomplish these learning objectives, there are several steps that are
involved, including:

Exercise 1.1: Introducing iSeries Web Development Tools
Exercise 1.2: Introducing the Web customer inquiry application

The exercises in this module must be completed in order. Start with Exercise 1.1
when you are ready to begin.

Length of time:
This module will take approximately 10 minutes to complete.

Exercise 1.1: Introducing iSeries Web Application Development

With Development Studio Client you can make your iSeries applications and data
accessible beyond the green-screen interface. You can create a new Web interface
that connects directly to your program’s input and output parameters.

You can create interactive Web pages using Web development tools. Use the Web
Interaction wizard to define how your pages interact with one or more ILE or
non-ILE applications. This wizard generates Java Action classes and JSP files for
use with data from HTML forms. When the end user enters data in a form, the
input becomes data to your ILE and non-ILE programs, and the output from the
programs is formatted for the Web. Your ILE and non-ILE logic can be separated
into different programs for each stage of input and output (known as a Web
interaction), or can be a single service program with entry points to handle each
Web interaction. The following diagram illustrates the Web development tools
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process:

9| web Page | Web Page
I J * input value * output value

Action classes |

. RPG program J

(input value --> input parameter)

You can easily customize your HTML and JSP files using the editing tools in Web
development tools. You can use these tools to create and update input forms,
change the appearance or placement of blocks of text, and add backgrounds and
images to your pages. The iSeries-specific Web components help you create Web
versions of your input and output pages with the same kinds of input validation,
output formatting, and subfile controls that native DDS screens provide. You do
not need a detailed knowledge of HTML or Java to accomplish these tasks.

You have an easy test mechanism for your Web-enabled applications. You can
easily run your program in the WebSphere test environment of the workbench,
quickly make changes, and retest, rather than redeploy your application every time
you want to verify functions. When you are finished, you can package and deploy
your Web applications as J2EE-based Web archive (WAR) and Enterprise Archive
(EAR) files, and then install them in a WebSphere Application Server.

Exercise 1.2: Introducing Web customer inquiry application

2

By the end of this tutorial you will have created a simple e-business customer
inquiry application that uses a Web-based front end to communicate with RPG
business logic residing on an iSeries server. You will first create a representation of
a Web interaction in a Web diagram. You will then invoke the Web Interaction
wizard to create the input and output pages and to create the servlet to invoke the
RPG program or service program to get data from the iSeries database. Next you
will add this RPG program or service program to your Web application. You will
then run the application in the local test environment on your workstation. You
will also create an informative error page for when a customer enters an incorrect
customer number.

Here is what the finished e-business customer inquiry application looks like:
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After the WebSphere server has started, your Web application Customer Inquiry
input page (inquiryjsp) will display in the workbench browser:

+ ] Welcome W X |

Ihttp:,l',l'lclcahclst:QDBDIwintlabxx,l'hquiy.isp ﬂ °| oo @

Customer Inquiry

Enter customer number; 0010100
Reset

Done I

When you enter a customer number and click the Submit push button, the
Customer Details output page (result.jsp) appears:

+ ] Welcome w X |

Ihttp:,l',l'lclcahclst:QJJSD,I‘wintlabxx.fl:ustlnquiry.do ﬂ -] | F o5

Customer Details
Customer Number: Q010100

Customer Name: Meridien Electronics Limited
Representative Number: 43443

Contact: Alfredo Bayonne

FPhone Number: 206-865-4027

Fax Number: 206-865-4037

Address: 10423 S E. 30th Place

City: Bellevue, WA

Country: USA.

Zip: 98007

Submit | Reset

Next, you click the ‘@ Back button in the browser to return to the Customer
Inquiry input page. Here you enter an incorrect customer number and click

Chapter 1. Module 1: Introducing the Web customer inquiry application
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Submit.

T |

|http:,f.fhcall'mt:QOBGIMntIabxx.finquirv.jsp j > | oo

Customer Inquiry

Enter customer number: {9999
Reset

Done

An error message appears.

|http:.f.fbcalhost:QOBDIMntIabxinmuiry.jsp j ° S @ @

Customer Inquiry

Enter customer number: d| Customer number 9 not valid

Reset

—

You then add a new output error page to improve the message information so that
if a wrong customer number is entered,

Ihttp:,l',l'lclcahclst:‘B'EIBIJ,l'MntHJxx,l'i'uuiy.isp j Q<= @ @“? = | D
=

Customer Inquiry

Enter customer number: 9999 _
Reset
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an error page opens instead of a message.

I http: fflocalhast ;9080 wintlabix fcustInguiry.do j =20 @“? = | D
Sorry, there iz no record for that customer number,
Please check the number and try agan

Done

Recap
Congratulations! You have completed Module 1: Introducing iSeries Web Tools and
Web customer inquiry application. You should now understand:
* What components make up Development Studio and Development Studio Client

* What components are included in the advanced edition of Development Studio
Client

¢ What components are included in Application Developer

* What components are included in Site Developer

¢ What tool you use to manage your development cycle tasks
* What the benefits are of Remote System Explorer

* What tool is used to edit source members

* What tool is used to debug programs

* What tool is used to design screens

* What tool you used to save compile time

* The purpose of the Remote Commands view

* The capabilities of each iSeries development tool

Now that you have this introductory knowledge of Development Studio Client,

you can continue with Module 2: Starting Development Studio Client and the
Remote System Explorer.

Chapter 1. Module 1: Introducing the Web customer inquiry application 5
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Chapter 2. Module 2: Creating a Web project

In this module, you will learn how to create a Web project and then supply the
information which the iSeries server will use for serving the business information
for this Web application.

Remember: Before beginning this module, you should learn about the Prerequisite
knowledge for the tutorial.

In order to create a Web project for the Web application and set iSeries server
information, there are several steps you will need to learn about and follow:

* Understanding a perspective

* Understanding J2EE settings

¢ Understanding a Web project

* Understanding the iSeries Web Tools Run-Time Configuration wizard
* Creating a Web project

* Creating the iSeries server information

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Exercise 2.1: Starting the Development Studio Client workbench
* Exercise 2.2: Opening the Web perspective
* Exercise 2.3: Creating a Web project

* Exercise 2.4: Setting up the iSeries server information
The exercises in this module must be completed in order. Start with Exercise 2.1
when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Exercise 2.1: Starting the Development Studio Client workbench

Now go ahead and start Development Studio Client.

On your desktop taskbar:

» EI Development Studio Chent Advanced Edition for iSeries 5.1 »
A& Development Studio Client ditic Series

( T ID Workbench
@ WS_FTP ProEx )
7] Java 2 Runtime Environment

Stark or Configy Q Lavasoft Ad-aware 6
= 7] Lotus Applications

El\ﬂuml’t Word ﬂ Lotus SmartSuite
7 Microsoft Office Tools

v
»

3

»

»

Eeic Edibor a Metscape Communicatar 3
) Morton Ankivirus Corporate Edition 3

F7) Object REX for Windows ’

) Palm Desktop 3

] QuickTime »

All Programs
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1. Click: Start > All Programs > IBM® WebSphere Studio > Development Studio

Client Advanced Edition for iSeries 5.1

A dialog for workspace selection will appear asking you for the workspace
location, unless you used the Development Studio Client before and selected
not to show this dialog again.

WebSphere Studio ﬁl

WwiebSphere Studio stores wour work in a directory called a workspace. You can change the workspace each time
pou start WebSphere Studio. Specify the directomny to use for this session:

IE:'\Doeu'nEﬂs and SettingsypurnichiMy DocumentshIBMywdschwintlabes Browse... I

[ Use this workspace as the default and do not show this dislog box again

[ ok | cancel |

The workspace contains all the information about your Development Studio

projects. You can accept the default or store the work related to this tutorial, in
a separate workspace.

To name the directory of the workspace as shown above, use the directory
name wintlabxx.
Click OK.

After a few moments of loading, the workbench opens, and the initial window
of Development Studio Client appears on your desktop:

-@: Remote System Explorer - Welcome - WebSphere Development's € - |I:I|5]
Fil= Edit Mavigate Search Project Run Window Help

|S-HEe[O]3s-%-%-||2[[AFM[|% - -

E Remot...tems = x ||[Q=RIL X | Outline X
I & ¢ o o ¢ [lIDevelopment St...

- a | An outling is

oo = fThis page tells you what vou should know befare you—4 not available.

3 Development Studio Client Advanced Edition For iSerie
E’& U G and click on the related links,
E-Y windows...

(4] e b
3’( t:::-:( 3 Get started

o Ta know what to do first, consult the Product Ov
B Locdl.. the infarmation map in the online help to decide F
. iSeties... start using the product.

{3 Develop iSeries applications
‘You can create and maintain RPG and COBOL app
Learn more about the Remote System Explorer a
4 I

| |
1 remote System Detais [+Bg®| © = & v x

< [ 2]

Remote Systems | Team |

Properties v X
e 5
Property | Value

4| | » | | Remote System Details |Tasks jiSeries Table View |iSeries Commands Log
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Exercise 2.2: Opening the Web perspective

In this exercise you will use the Web perspective. This allows you to access tools
and views specifically related to Web application development. However, when
you first start the Development Studio Client workbench you see the Remote
System Explorer (RSE) perspective by default. This is the perspective that you
would use to work with iSeries objects. It allows specifying connections to iSeries
servers and provides the programmer a similar interface to iSeries objects as the
Program Development Manager (PDM) does in a green-screen environment.

Perspectives

Before we go further, let’s review perspectives. Perspectives are a collection of
views and tools assembled to help different kinds of users to do their job when
they use the workbench. These workbench users will have different jobs (roles), for
example, one user needs to work with iSeries objects related to RPG/COBOL,
another user is dealing with Java programs, and another user with Web page
development. Each of these different user types will need different views of the
files/objects they are working with and they need different tools. The perspectives
present the user with a selection of specific views/tools geared towards the
different roles the users have. The workbench has many predefined perspectives,
like the:

* Web perspective for Web developers.
* Remote System Explorer perspective for iSeries programmers.

You can also create your own perspective by using the Save Perspective as option
under the Window menu in the workbench, after you have modified a perspective.
Now that you know what a perspective is we can go ahead with our exercise. You
are a Web developer in this tutorial and that is the reason you will select the Web
perspective. The Web environment provides its own perspective since it needs to
give its users access to unique views and tools targeted towards Web tasks.

You create a Web project in the Web perspective.

To open the Web perspective:

Project Run | Window Help

J ﬁ « & ~ NewWindow

 Open Perspective d & TaRemcte System Explorer
#(}57 Showe View »
3 Hide Editors [ Other.. |

1. Click Window > Open Perspective on the workbench menu.

2. Then click Other on the pop-up menu.

Chapter 2. Module 2: Creating a Web project 9



The Select Perspective window opens:

4P Select Perspective X|

I WJava

St'Java Erowsing

Java Type Hierarchy

=] Plug-in Development

d} Prafiling and Logaing

%Remote System Explorer {default)
Resource
Server

[ Jweb

%WebFacing

[X] %rL

IQXSL Debug (=

3. Select Web from the list.
4. Click OK.

The workbench will now show the Web perspective with the Web Projects view
open on the left hand side.

dp web - Welcome - WebSphere Development Studio Client Advanced Editionie -10] x|
Fil= Edit Mavigate Search Project Run ClearCase ‘Window Help
& -B8 8 IENEIERENEL
|omMONEBA P2 AR TeEme (& -|(|® ¢
|AAB[C & - -
E Project Mavigator w» X x ‘ @ Palette x
& & palette is not available
a o E RS Develo... For this editor
’E This page tells you what you should kn;
[. Development Studio Client Advanced E
# and click on the related links,
3 Get started
To know what to do Ffirst, consult t
the information map in the online =
skart using the product,
Project ... | Galery (St4 b
3 & Develop iSeries applications
(@) Attributes X You can create and maintain RPG .
Mo attributes are available Learn more about the Remote Sys
Remote System Explorer
To navigate through your iSeries ¢
The First thing you need to dois ct »
« | = _T‘
QuickEdt 5 - T w x
il ;Izi
nttrbutasJSLers (Thed b Qui:kEdtJTasks | Colors | Servers PalatteJSnIppets

Exercise 2.3: Creating a Web project

Web projects hold all of the Web resources that are created and used when
developing your Web application. The first step to creating or importing a Web
application is to create either a static or a dynamic Web project. Static Web projects
are meant to contain only simple Web site resources, such as HTML files. Dynamic
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Web projects are used to structure Web applications that will use more
complicated, dynamic Web technologies, such as JavaServer Page files, and
possibly data access resources.

To create a Web project:
1. Click File > New on the workbench menu.
2. Then click Dynamic Web Project on the pop-up menu.

File Edit MNavigate Search Project Run ClearCase ‘Window

 proc..
Close Chrl+F4 r——
Close all Chrl+Shift-+F4 S==lss==
& Static Web Project
M see ChrS & Folder
W] save fs, . &N HTMLJKHTML File
ﬁ Save &l Chrl+5hift+5 @\ 15P File
Revert
r ga} JavaScript File
[ é Serviet
Rename. .. '@' Fika
.
Refresh % Life-cycle Listener
&b Frint... Chrl+P F Template Application
g2y Import... = Example. ..
&5 Export... 50ther...

This starts the Web project wizard. The initial page of the Web project wizard
opens.

On the Dynamic Web Project page:

&b New Web Project _ x|

Dynamic Web Project

Specify a name and location for the new Web project, m

Project name I winklabooe

Project location: I D:\WorkSpace_WDSCvS1\WebToolsTutorialvS 1 ywintlabooe Brawse. .. |

@Conﬁgue advanced options

< Barck (l Mext = |1 Finish I Cancel

———

3. In the Project name field, type wintTabxx.
4. Accept the default value in the Project location field.

This is where your project is stored in your file system.

Chapter 2. Module 2: Creating a Web project 11
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5.

6.

Select the Configure advanced options check box to specify or customize the
project options, such as adding Struts support to your Web project.

Click Next.
The J2EE Settings page opens.

This page allows you to specify the J2EE level for the Web project. If you plan
to use the WebSphere Application Server version 5 only then you select J2EE
level 1.3. If you are using previous versions of WebSphere Application Server
in your environment and are planning to deploy the Web application to these
versions then you use J2EE level 1.2 since these earlier versions of WebSphere
Application Server don’t support the J2EE level 1.3. In this exercise you use
the Web application in the WebSphere Test Environment, which is version 5,
so you use J2EE level 1.3 which is the default.

&b New Web Project _ x|

JZEE Settings Page
Set the Enterprise Application project settings, context root, and JZEE level. m

EAR project:,_| SlxNElsFeill

Context root: | wintlabxx

JZEE level: ‘ -

JZEE Level 1.3 indludes a Servlet Specification level of 2.3 and a ;l
JSP Specification level of 1.2, Applications developed fFor this J2EE
lewel typically target a WAS version 5.0 server,

=

<Back |®|| Fish | Cancel [
——

7. In the EAR project field, type wintlabxxEAR.

A new or existing Enterprise Application project must be associated with your
new Web project for purposes of deployment.

The Enterprise Application project is new, so you typed the name of the new
project. When your Web project is created at the end of the wizard, the new
Enterprise Application project (EAR file) is also created. The default is an
Enterprise Application project named DefaultEAR located in the same
directory as your new Web project.

Leave the default value for the Context root field.

The default value for the context root is the name you provided for your Web
project. The context root is the Web application root, the top-level directory of
your application when it is deployed to a Web server. The context root can
also be used by the links builder to ensure that your links remain ready to
publish as you move and rename files inside your project.

Leave the default value in the J2EE level list.
By default, the Web project’s J2EE level is set to the Workbench’s J2EE level.
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10.

11.

12.

13.

14.

15.

Any new servlets and JSP files that you create should adhere to the latest
specification level available; previous specification levels are offered to
accommodate any legacy dynamic elements that you expect to import into the
project.

Click Next.

The Features Page opens:

&b New Web Project . x|

Features Page

Select a Web Project feature. A feature can provide additional functionality For the
‘Web Project.

‘Web Project features: Description;
| dd Struts support Select this feature to have support For LI
T[] Default style sheet (S5 file) Struts added to your project

~ ] Default synchronization palicy for CYS ¢
:@}eri&s Web Components Tag Library
[=1-[C] 35P Tag Libraries

--[] 35P Standard Tag Library

‘[ Taq Libraries For accessing ISP abie

-+[] Tag Libraries for database access

-+[J Tag Libraries for internationalizatior
[ ukility Tag Libraries

< | W d|

<Back | MNext> || Finsh |  Cancel [

Select the Add Struts support check box as you want to create a project that
uses Struts technology.

Leave the default Default style sheet (CSS) check box selected to create a
default CSS file (called Master.css) for any HTML and JSP files included in the
project.

Select the iSeries Web Components Tag Library check box as you want to
add iSeries fields and controls to the Web pages of your Web application.
Click Next to go to the Struts Settings page and ensure that Create a Resource
Bundle for the Struts Project is selected. If not, select the Override default
settings check box and then select Create a Resource Bundle for the Struts
Project.

Click Finish to create the Web project.

Chapter 2. Module 2: Creating a Web project 13



Now you are back in the workbench and your new project and project files
appear in the Project Navigator.

?5 Praject Mavigator v X

1= wintlabxx
ﬁ wintlabxxEAR

Praoject Navigator |Galler&_ar | Struts Explorer

Exercise 2.4: Setting up the iSeries server information

Before you can start creating your application, you will need to define where the
RPG program you will connect to later on in this tutorial is located. You need to
specify the iSeries server name and the user-ID and password to be used when
starting the job on the iSeries to run your program.

To set up the iSeries server:

1. In the Web perspective, right-click the wintlabxx project in the Project
Navigator.

v X awdcome X|

Development Stw

(#1155 wintlab Mew »
Go Into
Go To »
Open in Kew Window

Capy
Paste
Delete...
Move...
Rename...

Impart...
Expart...

Rebuild Project
Refresh

Run Yalidation
i) Debug on Server...
ja Run on Server...
& Frofile on Server...
Add JET Mature
Add SQLI Support...
Converk to Web Site

Restart Project

Project Mavigatc

aktributes
Mo attributes an

un-time Configuration ...

2. Click Specify iSeries Web Tools Run-Time configuration on the pop-up menu.
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Tip: You could also use the & button from the workbench toolbar to get the
Runtime configuration wizard..

The iSeries Web Tools Run-Time Configuration wizard opens:

4P iSeries Web Tools Run-time Configuration _ x|

iSeries Web Tools Run-time Configuration
Specify the run-time configuration for program call of iSeries Web development tools g

iSeties host name

-
[ s400a \

| widsclabi:

User ID

@mble password-encoding

I Prompt For iSeries user 1D and passwaord

- Rurikime library lisk

Library: | £dd
Library | Library Position |
Remave |
[eve Up |
Mave Down |
Current lbrary: | *USRPRF =]

Initial command:

|
@sphv detalled runtime errors

I Use program call JCA connector
Specify the JNDI name |

(I

You use this wizard to specify how Web interactions that perform program calls
to an iSeries host should be connected and authenticated.

In the iSeries host name field, type the name of the iSeries host where your
program is located, for example s400a.

Enter your user ID and password for the iSeries host in the appropriate fields.

You need to ensure that your User ID has been set up in a way that it contains
the correct library list. If not, you will have to use this table to add a library to
the library list when the job gets started to run your program.

Select the Enable password-encoding check box. This option ensures that the
password appears in encoded format in the web.xml file. If you clear the check
box for this option, the password appears as plain text in the web.xml file.

Select the Display detailed runtime errors check box to see the details for any
errors that occur during the run time of your Web application. This is useful for
tracing and debugging development errors that may occur.

Click Finish to define authentication and run-time values for your host
program or procedure call to be made by your Web interaction in the Web
project.
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Recap

Congratulations! You have completed Module 2: Creating a Web project. You
should now understand:

¢ How to start the workbench

* The concepts of the workspace and perspectives, the Web perspective and J2EE
settings

e The importance of creating a Web project

* The importance of setting up iSeries run-time configuration information
* How to open the Web perspective

* How to create a Web project

* How to set up iSeries server information

Now that you have created a Web project, you can continue to Module 3: Visually
constructing the Web application.
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Chapter 3. Module 3: Visually constructing the Web
application

In this module you will learn how to create a representation of a Web interaction
in the Web diagram by adding JSP file nodes and an action mapping node to the
free-form surface. You will learn how to draw connections to or from the nodes
and the action mapping node. In the next module you learn how to invoke the
Web interaction wizard to create the JSP files and to define and generate the Web
interaction.

In order to visually construct the Web application, there are several steps you will
need to learn about and follow:

¢ Understanding Struts

* Understanding the Web Diagram palette
* Creating various Web objects

¢ Making connections between Web objects

* Using the Web Diagram tool to predefine variables for the Web Interaction
wizard

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Exercise 3.1: Creating a new Web diagram
* Exercise 3.2: Plotting your new Web project

The exercises within this module must be completed in order. Start with Exercise
2.1 when you are ready to begin.

Length of time:
This module will take approximately 10 minutes to complete.

Exercise 3.1: Creating a new Web diagram

A Web diagram is a view that helps you visualize the flow structure of a
Struts-Based Web Application. Because of the indirectness involved with a Struts
application, being able to visually see the application’s flow can help you to better
understand the application.

Struts

Before you create a Web diagram, let’s first look at what Struts is all about. First,
Struts is a set of Java classes and JSP tag libraries that provide a conceptual
framework for developing Web applications. The Struts technology is open source
and was developed as part of the Apache Software Foundation’s Jakarta project.

Second, Struts provides numerous, custom JSP tags that are simple to use but are
powerful in the sense that they hide information. The Page Designer does not need
to know much about form beans, for example, beyond the bean names and the
names of each field in a given bean.

Third, you can use the diagram editor to show all or part of a Struts application.
For example, suppose you have a three-part Struts application. One part handles
the login process, one part handles product inquiries, and a third part handles
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product updates. In this case you could draw three diagrams to represent this
system, or you could draw the entire system in a single diagram. Because one
diagram can be included inside another, it would probably make more sense to
represent this Struts application using a set of three diagrams.

Now, that you know what Struts is, you can go ahead with this exercise.

To create your Web diagram:
1. Click File > New on the workbench menu.
2. Then click Other on the pop-up menu.

The Create a new Web diagram page opens:

Xl
Select o @
[)
Create a new Web diagram ﬁ
-+ Component Test A1 |4 action Class
5 Data ‘& Action Mapping
- Eclipse Modeling Framework 6 ActionForm Class

-~ EIB
- Example EMF Model Creation Wizards CI
[+ i5eries

i J2EE

E| Java

- Plug-in Development
- Remote File Transfer
- Server

- Simple

- Symptom Database
} jzation

Web Diagram
ation File

(&]5truts Module

ﬁ Struks Exception

- Web Services _I
-

Poownal

Finish I Cancel I

3. In the left pane of the Create a new Web diagram page, expand Web and then
select Struts.

4. In the right pane of the Create a new Web diagram page, select Web Diagram.
5. Click Next.

18 ILE RPG e-business application



The Specify the name of the new Web diagram file page opens:

4P Create a Web diagram ; ﬁl

Create a Web diagram.

Specify the name of the new Web diagram file. @

Enter or select the parent Folder:
I winklaboe

2o
[#-1z% RemoteSystemsCannections
1= RemoteSystemsTempFiles
+-{zp Winklabxx

158 wintlabxxEAR

Madule: |<deFaut module= :l

Advanced > I

e
<Back | wen | Cancel

Select your project wintlabxx.

In the File name field, type wintlabxxDiagram as the name of the diagram.

The .gph file extension is automatically applied to the name.
Click Finish to create the file in your project.

Chapter 3. Module 3: Visually constructing the Web application
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The file opens on a free-form surface in the editor view:

db web - wintlabxxDiagram.gph - WebSphere Development Studio Clie : - |I:I|ﬁ
File Edit Mavigate Search Project Run ClearCase ‘Window Help
¥ -EH& & IEEAEERENELS
|oMONEBAP 2D AR LT Eme ([&-||® ¢
|AAB| -2 6 ||
E Proje...gator w X || | |‘Welcome |ﬂl.-'-.-intl:=bxx: XI Palette X
Qe > w K A
# 1= wintlabyx Select
’E a8 wintlabxxEAR lECunne.'.
|5
4 [% stru.., #
Action
Mapping
Node
Form
eEean
Project ... ‘Gallary 4) Node
Java
(3) Attributes x Bean
MNode
Fs| web
Mo attributes are availe Page
Node
=\ | i, web
4 » Applic. ..
Node
[E Quick Edit G v B oo - x |[@E)stuts
Madule
Ll f Node
nttrbutasJSLers 4 » || Quick EdtITasks|Cdnrs|Sarvars Pabtte]i »

After you create a Web diagram, you can add JSP file nodes and an action
mapping node to the free-form surface in the editor view to represent the Web
interaction that you want to generate.

Exercise 3.2: Plotting your new Web project

20

Let’s become familiar with some of the icons in the Palette. Locate these icons in
the Palette view on the right of the free-form surface in the editor view.

* Select ik Select i in the Palette view is used to select the objects on the
diagram.
* Connect Two Nodes **Comnection in the Palette view is used to connect

two objects (nodes) on the Web Diagram together to create a flow in the design.

+ New Action Mapping Node #ActionMappinghiode iy the Palette view is used to
create a Web Interaction Node.

+ New Form Bean Node & FormBean hode in the Palette view is used to create a
Form Bean Node.

« New Java Bean Node @ JavaBeanNode in the Palette view is used to create a
Java Bean Node.

+ New Web Page Node £l Web Page Node in the Palette view is used to create a
JSP Node.

In this exercise you use the Web Interaction Node and the JSP Node to plot your
Web Project.
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To plot a Web project:

1.

10.

Select New Web Page Node £l Web Page Node in the Palette view and click
somewhere to the upper left in your Free Form Surface (FES).

This creates a JSP Node.
Rename the JSP to inquiry.jsp.

Select New Web Page Node FJ Web Page Node again in the Palette view. To
create another JSP node, click in your FFS again, somewhere to the right from
the first jsp you created. Name this JSP node result.jsp.

Select New Action Mapping Node % Action Mapping Node in the Palette view and
click somewhere in your FFS.

This creates a Web Interaction Node.
Rename the Web Interaction to custInquiry.

Select Connect Two Nodes *Connection in the Palette view to connect
the nodes together.

This tool is direction sensitive, so make sure you do the following steps in
order.

Click inquiry.jsp and click custInquiry.
This creates a link between these two nodes with an arrow that indicates that
the page is input to the action

Connect Two Nodes **Comnection is still selected. Now click
custInquiry then click result.jsp.

Press Enter to accept the new name.

Select Select ly select i in the Palette view to switch to select mode.
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Your Web Diagram should now look like this:

&b web - wintlabxxDiagram.gph - WebSphere Development Studio Client - |I:I|5j
Fil= Edit Mavigate Search Project Run ClearCase ‘Window Help
-8 & IEXNEIERENEL
oo P2 A BhTOHme |[%-||® 5
|AAB|s a2 6|l
= P.r w X || []Welome 5 *wintlab e X (55 Palette X
Bglle = ® =
’a o I[fa Select
== 3-@ wintlz & w—+ Connection
@y L
-8 1 W fcustInguiry - Action
— - ‘x Mapping
: -2 "fv ms:| - : = Node
- r-mh L B &) Form Bean
A » o
inguiry. jsp Node
Project ... 4 P result.jsp] @ 12vakean
—_— Node
Attributes X £] web Page
|L| Node
4 [» Web
i : Applicati
Mo atbributes a B QuikEde S B v x NEE:’ on
- (& 5truts
"'"" Maduls Node
Kl ;I—I
Altributes 4 b | | Quick EdtITasks|Colnrs | Servers Pabtte]Snippets

11. Click the Save icon on the workbench toolbar to save the Web diagram.

Recap

22

Congratulations! You have completed Module 3: Visually constructing a Web

application. You should now understand:

* The purpose of Struts

¢ The purpose of a Web diagram

* How to create a Web diagram

* How to plot a Web project

* The features in the Web Diagram palette

Now that you have your entire Web project planned out and ready for
implementation, you can continue to Module 4: Creating a Web interaction.
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Chapter 4. Module 4: Creating a Web application

In this module, you will learn how to create the interaction to use an input and
output page, and to create the servlet to invoke an RPG program to get data from
the iSeries database.

Remember that you have a Web diagram where you already defined the name of
the interaction, the input and output pages. You will invoke the Web Interaction
wizard from your Web diagram.

In order to create a Web interaction, there are several steps you will need to learn
about and follow:

¢ Understanding an interaction
* Understanding input and output pages
* Accessing an iSeries database from a Web browser

* Using existing DB2/400 field definitions to create the necessary Program Call
Markup Language (PCML) information to be able to communicate with an
iSeries program

* Using externally described iSeries fields in your Web pages

* Getting data from the iSeries by invoking an iSeries program that accesses the
database and returns the data through parameters

* Reading and writing data from and to a Web page

¢ Creating an input (inquiry) page for a Web application with the Web Interaction
wizard using the Web diagram input page

* Creating an output (result) page for a Web application with the Web Interaction
wizard using the Web diagram output page

¢ Generating Java code for servlets using the Web Interaction wizard.

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Exercise 4.1: Invoking the Web Interaction wizard

* Exercise 4.2: Specifying input and output pages

* Exercise 4.3: Defining the iSeries program invocation and parameters
* Exercise 4.4: Invoking a service program

* Exercise 4.5: Defining the structure information

* Exercise 4.6: Adding reference fields from DB2/400 to the structure
* Exercise 4.7: Adding more parameters to the program definition

* Exercise 4.8: Defining the structure as a parameter

* Exercise 4.9: Adding a feedback parameter

* Exercise 4.10: Defining the input page content

* Exercise 4.11: Defining the output page content

 Exercise 4.12: Specifying error handling

* Exercise 4:13: Enhancing the output page

* Exercise 4.14: Ensuring the customer number field cannot be modified

The exercises in this module must be completed in order. Start with Exercise 4.1
when you are ready to begin.
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Length of time:
This module will take approximately 20 minutes to complete.

Exercise 4.1: Invoking the Web interaction wizard

During this exercise you will use the Web Interaction wizard to create the interface
description for parameters to be passed to an iSeries program. You will also
generate a Web page based on the parameters definition used by the program.

Some of the parameters will be defined based on existing iSeries database field
definitions.

To invoke the Web Interaction Wizard from your Web Diagram:

cﬁ: Web - wintlabxxDiagram.gph - WebSphere Development SEui

 Clie = (=]
Fil= Edit Mavigate Search Project Run ClearCase ‘Window Help
|5 -BR & 2% (=8]8 [
oo P2 A BRhEome & o ¢
|AIAA| w226 [Tl |hn.mn
g P.r w X || []Welome W X | (5 Palette  x
% =T -
’3 oo [s Select
I_ = 1= wintl - oo w—s Connection
2| %x 'I ke S Struts T, #
'LB 1— 3 .fE-..Lv_ e AL B eFien
@ e ,,-" 4 Connection
i Ll-:I- P B ’
4 » R
inquiry. jsp
Project ... 4 b e '
Attributes X
1 Web Interaction W
4
Mo attributes a | [ = 3
=1 Quick Edit k Change Path
k Change Description
k Change Module Association
o & Undo Move Object
Attributes 4 # || Quick Edit |Tasks | Colors | Ser i : |

X Delete F

1. Right-click custInquiry action mapping node in your Web diagram.
2. Click Open iSeries Web Interaction Wizard on the pop-up menu.

An interaction is the span between the submit of a request from the current
Web page to the post of a new Web page. An interaction could be a simple
request to the HTTP server to load another page. In this environment an
interaction will be made up of a call to an iSeries program, waiting for the
return of the program with data and then invoking a JSP to show the next Web
page containing the data returned from the program.

First you have to give the interaction a name so you can reference it later on,

but since you invoked the interaction from your Web diagram, the name has
already been filled in for you.
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The Specify a Name and Location for your Web Interaction page opens:

4B web Interaction

Specify a Name and Location for your Web Interaction

Define the nae and locstion For the conmunication betwesn Web pages and the chosen business process. The location must be the web Cortent drectory inside 8 project. 0%
ion folder | fwintlaboo:WebConkent am...|

Web Interaction name | rustinguiry

Java package | B:m...l

[ Use error page | I

[ Irvabidate session after the i tion occurs

3. Click Next in the Web Interaction wizard.

The Specify the Input and Output Pages for your Web Interaction page opens.

Exercise 4.2: Specifying the input and output page

The next page of the Interaction wizard asks for information about the Web pages

that are involved in this interaction. You have an input page that invokes the

interaction and an output page that displays the results of interaction. The output
page shows in the browser at the end of the interaction. The wizard generates both

Web pages for you. Since you plotted the input and output pages in the Web
Diagram, they are already listed as pages to be created by the Web Interaction

Chapter 4. Module 4: Creating a Web application
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Wizard.

\{b Web Interaction 1'
specify the Input and Output Pages for your Web Interaction
You can use previously designed input and output pages for this Wb interaction o you can have the wizard generate them, o@e
Page preview:
& Generate nput J5P
€ Use frput pages:
fingury. jsp Addd.. ]
Remove 1
Prewien ]
1+ Generate output J5P
€ Use outpet pages:
fresult.jsp #idd., !
Remove ]
Presies 1
< Back. Next > Firistt Cancel

1. Click Next.

The Specify the Input and Output Parameters for your iSeries Host Program
page opens.
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Exercise 4.3: Defining the iSeries program invocation and parameters

The next page asks you to define the parameters you want to pass between the
Web pages and the iSeries program that processes the requests.

& Web Interaction : x|

specify the Input and Dutput Parameters for your iSeries Host Program

Lise thes page to define the input and output parameters for your Senies host program. 00@
Program cal definitions Add Program... | fidd Parameter, .. | Add Structure... |
=
| Add Program
Program alias: | custinguiryP G \
Program object: [GeETDATA } Browse...
Library: wssu_nax:d/
Program type: |*Par =l
Entry point; [
CCSID of entry point: |
Return bype: I'\ oid LJ
Theead safe: [fate =l
Source location: | ;] e,
'7 -'ﬂ::cli'.'_‘:'::")g"." LILTY Lpe ITer ACUon
Import PCML... Synchronize Al
o
<gack | meas First Cancel

To define the program that you want to call on the iSeries:

1. The Use an iSeries program or procedure radio button is selected by default.
You use this page of the wizard to describe the program or procedure that is
invoked as the business logic for this Web interaction.

2. In the Program alias field, type custinquiryPGM.
This value is used when creating the Java classes for this interaction.
3. In the Program object field, type GETDATA.
This is the name a program object or a service program object.
4. In the Library name field, type WSSLABxx.
This is the name of the library that contains the program object.
Now you have to make a choice for program type.

To work with Service programs and procedures in Service programs follow the
steps in Exercise 4.4: Invoking a service program.

5. To work with a regular program, leave the Program Type field as *PGM.

6. Click OK in the middle of the Add Program pane to add the program
definition to the Program call definitions area of the page.

7. Click Yes, if you are asked to save the changes.

8. Follow the steps in Exercise 4.5: Defining the structure information for *PGM
and *SRVPGM invocation.

Exercise 4.4: Invoking a service program

Follow these steps if you want to work with procedures in service programs.
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If you want to invoke a regular *PGM from your Web page then go to Exercise 4.5:
Defining the structure information for *PGM and *SRVPGM invocation.

The Service program you call will have a different name, so first change the
program name:

1. Select the Program object field.
2. In the Program object field, type GETDATAS
3. Select *SRVPGM from the Program type list.
4. In the Entry point field, type getrecord.
This is the procedure name in your service program.

Note: Enter the Entry point name in lower case.

5. Click OK to add the program definition to the Program call definitions area of
the page.

6. Click Yes if you are asked to save the changes.
The special instructions for calling a Service program ends here.

|
Specify the Input and Dutput Parameters for your iSeries Host Program
Usse thes page bo defire the input and output paraseters for your iSeries host program. g%
(" Lse an iSeries program or procedure ™ Use a Java bean € No proge
Program cal defintions £dd Program... [ PR — I WW“’-"I
=]l
;I Add Program
Program alias: I custinguiry®GM
Program cbject: | sErmatas \ Erowss... |
Library: | wsstagx l
Program type: |*srvpem j @
Entry poink: getrecord / -
CESID of antry point: | T—"
Faturn bype: Ivald _I
Thread safs: [patse =]
sourceosston: ! =i e
F ass
Import PCML.... Synchronize Al
@ Cancel |
<Back | e Firist Cancel

Exercise 4.5: Defining the structure information for *PGM and
*SRVPGM invocation

Now you add the parameter description for the program call. One of the
parameters is a structure. First you describe the layout of the structure and then
you describe the parameters.

To define the structure:

&dd Program... | fdd Earameter...d &dd Struckure... |!
[

1. Click Add Structure.
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In the right pane of the Specify the Input and Output Parameters for your
iSeries Host Program page, the Add Structure pane opens:

4B web Interaction

Specify the Input and Dutput Parameters for your iSeries Host Program
Usse thes page bo defire the input and output paraseters for your iSeries host program.

(% Lise an iSeries program or procedure ™ Use a Java bean € No proge

PProgram call definitions

&dd Program... [ mt&mu‘."] Mdﬁwnuo‘.,l
=7 custinguiryPGM =
;I Add Structure

Structure name: ( |0Jstrn|uc_)

Count:

- dm

Output size:

Min. version: |

Ma. version: [

Offset: |

fset from: [

Import PCML... Syncheonize Al
(AP

<gack | met> | Ensh | cocel |

In the Structure name field, type custinstruc as the name of the structure.
Change the Usage list to output.

The structure receives output from the host program.
Click OK to add the structure definition to the Program call definitions area on
this page of the wizard.

Prugﬁmﬂhﬂﬂw

% custinstruc )
i T

-
=

Import PCML,.. I Synchronize all |

This tells the wizard that the fields in the structure will only be used to transfer
data from the program to the Web page.
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Exercise 4.6: Adding reference fields from DB2/400 to the structure

In the right pane of the Specify the Input and Output Parameters for you iSeries
Host Program, the Add Parameter pane opens. It allows you to add fields to the
structure. These fields can be reference fields from DB2/400.

& Web Interaction i |
Specify the Input and Dutput Parameters for your iSeries Host Program
Speciy details sbout the parameter o use, Enter parameters manuslly o the table below or cick Specify to enter them usng database definition. 00@
# Lse an iSeries program or procedure " Use a Java bean . No program cal
Program cal definitions addprogram... | addparameter... | Add tructure... |

%, custinstruc ]

El custingiryp G =] Add Parameter
Parameter name: | |
Diaka bype: Ichaatte( vI
Structure name: | > I
Length I 'I
Frecision: I .t I
Count: I
Usage: |mu & output ’|
Initial vahe: I
™ Advanced...
Specify datasbase reference Fishd m Synchronize ]

s ———
Import PCML... Synchronize Al Show database field defnition o
<Back | meas ” First I Cancel

You use a record format on the iSeries to describe the layout of the structure so
you need to connect to the iSeries server to select the record format.

To add fields to the structure:
1. Click Add Parameter.

4dd Program... € Add Parameter...

) add Structure, ., |

2. Click Yes if you are asked to save the changes.
3. Click Specify.
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The Specify Database Reference Field window opens:

-ﬁa Specify Database Reference Field

Expand a connection, a filker, a library, a record, and a file, and select a Field.

onnesction...

4. In the left pane of the Specify Database Reference Field window, expand New
Connection.

The Name personal profile page opens:

Mame personal profile

Uriquely name user profile !

‘Welcome to Remote Systems. Connections can be sharable by the team or private to
you, Enter a profile name to uniquely identify you From your beam members., You will
decide for each new connection whether it is owned by the team profile or vour
profile.

Profile: | FURICH

= Back Mext > Firrish I Cancel

5. Click Next to accept the default profile.
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The Remote iSeries System Connection page opens:

Remote iSeries System Connection

Define connection information !

Parent profile: | VURICH =]

Connection name: | 54002

Host name: ( 4008 ) j

Description:

¥ Verify host name

<Back | MNext> [[ Finih | cancel [

6. Leave the default value in the Parent Profile field.

7. In the Host Name field, type the iSeries server name, for example, s400a.
(This is the same server name as you specified for the runtime.)

8. Click Finish.
You return to the Specify Database Reference Field window.

cﬁ: Specify Database Reference Field ' 5_]

Expand a connection, a filter, a library, a

| Property | Value
MName Mew C
Murmber of children D
Type A pron

[ aas | ciose If
|

9. Expand your server, for example s400a.
10. Expand *LIBL..
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11. Type your User ID and password, if prompted.

12.
13.
14.

15.

16.
17.
18.
19.

20.

b Enter Password ..’5.'

System type: I iSeries

Hostname: | TORASO7M

User1D: | wdsclabucx

Password: | i

I Permanently change user 1D
IV Save password

Select the check boxes to permanently store these two values then click OK.

Look for WSSLABxx.

If this library is not in the list of libraries, then expand Work with Libraries

and type WSSLABXX in the Library field of the Work with Libraries dialog. Click

OK.
Expand library WSSLABxx.

5P L
TS, Mib,prod-sys

#- i}, Q5v52.Mlib.prod-sys

@i, QHLPSYS *iib.prod-sys
-, QUSRSYS.Hib.prod-sys
() -Ji" RSELABOL.*lib.test-cur
o}, RSELABO1.*lib.test-usr
-, YARLABO1, *ib, test-usr
)l ELAB O st sy

1, WSSLABOL, Mib.kest Lk

=l ALLBACK. *file. pf-dta
M- TE ALLSALES.*file.pf-dta
-] BYREGION, *file If
CUSTOMER. *file.pf-dta

- Hf |F

] CUSTOML3, *file.F

-

[+

T

Expand the logical file CUSTOMLS3.
Expand record format CUSTOMO1.
Select the record format CUSTOMO1.

Click Add.

You should see a message on the bottom of the dialog that fields have been

added successfully.

i Field added successfully.

Click Close.
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Parameters are added to the structure.

Pragram call definitions

Impart PCML...

synchronize Al |

Exercise 4.7: Adding more parameters to the program definition

You continue to add more parameters to the program definition.

To add more parameters:

&b Web Interaction

Specify the Input and Dutput Parameters for your iSeries Host Program

Thee program to be rvoked by this nteraction,

% Use an iSeries program or procedure

Program cal definitions

o CADOR.
o CCITY
o coounT
oF cap

Import PCML... Synchronize All

=
A

€ Use a Java bean . No program call
Edit Program
Program alias: | cwstinquiryPGh
Frogram object: | GETDATAS Browse... |
Library: | wesLago:
Program typs: [+sropem B
Entry poink: I getrecord
CCSID of entry point: |
Return bype: |vaid EI
Theead safe: |False =]
Source locakion: | x| ew

¥ fissociate this program with the interaction
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1. In the left pane of the Specify Input and Output Parameters for your iSeries
Host Program page, select the custinquiryPGM program you added in Exercise

4.5.
2. Click Add Parameter.

Now enter the customer number as the input parameter:

&8 web Interaction x|
Specify the Input and Dutput Parameters for your iSeries Host Program e
Use this page bo define the input and output parameters for your iSeries host program, O@
(% Use an iSeries program or procedure " Use a Java bean €' Mo progran
Program cal defintions addProgram... | Add perameter... | Add Structure... |
= u& cusl:?s;r;;,::.0 ;I
:; CES‘INA | Add Parameter
af* REPNC Pararneber namme: cnumber
ar CONTAC Daka Lype: character =
:; ;:,?E Structure name:
o CADOR Length: < 7 -
ol CCITY Precisions =
oF coouT
oF P Count: [
_ sbamo Lisage: q@ -
) s Ra Initial vahse:
™ Advanced...
Specify database reference fiekd specky... |
Import PCML... Syncheonize All Show database field definition o, |
=
< Back Heot > Finich Cancel
3. In the Parameter name field, type cnumber.
4. In the Length field, type 7.
5. In the Usage list, select input.
This is the Input parameter that will be sent from your Web page to the
program.
6. Click OK.
7. If you are asked whether you want to save the changes, click Yes.
You have just defined the first parameter.
Exercise 4.8: Defining the structure as a parameter
Now you add the structure as a parameter to the program call definition.
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To define the structure as a parameter:

& web Interaction Xl
Specify the Input and Dutput Parameters for your iSeries Host Program
Uise this page bo define the input and output paramebers fior your iSeres hast program, 0@@
% Use an iSeries program or procedure " Use a Java bean € No progranm cal
Program cal definitions ﬁdd?mwunl nddggunder...l Add Sructure. .
= “—Q oustingtruc ;I
«f CUSTHO = Add Parameter
o CUSTNA
o REPNG Parameter name:
o CONTAC Daka type:
4F CPHONE
oF CRAX Structurs name:
o f* CADDR Length:
P carry )
: # CCOUNT Precision:
oF czP Count:
P cairo .
=5 :mthq_hwm L
1% crumber Initial value:
I~ Advanced...
Spexify database reference field Spefy... Synchronize ]
Import PCML... Synchronize All Show database field definition =i,
S
< Back Nest > Finish Cancel
1. In the Parameter name field, type struc.
2. In the Data type list, select structure.
3. In the Usage list, select output.
4. Click OK.
5. If you are asked, whether you want to save the changes, click Yes.

Your structure is now an output parameter for the program call, which means
it will pass data back from the program to the servlet running in the
WebSphere Test Environment.

Exercise 4.9: Adding a feedback parameter
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The program on the iSeries is written in a way that it will return a value to
indicate whether the action (accessing a customer record) on iSeries was successful
or not. If it was not successful the return value will contain a message number and
a value for a substitution variable. You need to add a third parameter to the
program call.
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To add a feedback parameter:

&P Web Interaction

Specify the Input and Dutput Parameters for your iSeries Host Program

U thes page to define the input and output parameters for your Seres host peogram.

# Lise an iSeries program or procedure

" Use a Java bean

= No program call
Program cal defintions dd Progr ’ Bar | add g
= o8, custinstruc _‘:J

4 CUSTHO = Add Parameter

4 CUSTHA

o REFNG Parameter name:

o conTac Data type:

o CPHOME §

o CFAX Structure name:

o CACOR. Length:

o ooy L

oF CCOUNT REEE

o CZP Count:

I ‘.-cr czPo Uuw -
B crumber Initial value:
gl struc {custinstruc)
™ Advanced...
Specify database reference fisld Spedify... Synchronize |
Import PCML... | vonize Al | Show database field defintion Show
i
(I EE]
< Back Het > Einish Cancel

P owbdpRE

Click OK.

In the Parameter name field, type feedback.
In the Length field, type 20.
Select output from the Usage list.

You have completed adding parameters.

4B web Interaction

Specify the Input and Dutput Parameters for your iSeries Host Program

Usa this page bo define the input and output parameters for your iSeries host program.

" Use an iSeries program or procedure

" Ukse a Java bean

[P P SRS addprogram... | A parsreer. . | add gruture... |

3 &%, custinstruc

(=0 custinquanyPam | Eaep t

1% crumber
@.'I strue {custinstruc) Parameter name Feedback
& cusmio Datatype: |
o CUSTNA =
&P REFND Sructure name ] ]
4 contac Length: R
4 CPHONE o - -
oF CFAX Frecision: | ]
«fF CADDR Count
4P carr ]N—d
4P CoouNT Usge: e
«fF czP Tratial vahue: ] —
«F CZIPLO
ai
™ advanced...
Specify database reference field Syneheonize
Irport PCML... | Syncheonize Al | Show database field defintion

ﬂﬂl_

s | @) ([T ] _ o |
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In the left pane of the wizard, you can expand custinquiryPGM to see all the
parameter definitions.

Tip: To move a parameter from its current position, use the arrows to the left of
this pane.

You are ready to go to the next page.
5. Click Next.

The interface between the servlet and the iSeries program is now defined.

Exercise 4.10: Defining the input page content
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Now you need to specify which of the input parameters you specified you want to
see on the input page for this interaction that gets generated by the wizard. This is
easy in this application since you only have the customer number input field to
handle. You also have the capability to enhance the page layout by changing colors
of the page background and changing the heading. The Design the Input Form
page contains a properties table that shows all input capable parameters, and a
sample of the Web page that will be created.

& Web Interaction i |
Design the Input Form
Specfy the page properties and the input parameters that the generated Web page vall expose to the user for nput, 00@
Input parameters: ﬂ
1® cruumber Move up .
[ Customer Inquiry
Mowve down
al cnumber I
Nong
|
Page Tite Customer Inguiry
Background Color s
Tithe Color
Fiedd Color
oo Gek) =
<geck | meas [[Emeh | concel

To change the heading:

1. Click the field beside the Page Title property in the Property table and type
Customer Inquiry.

2. Press Enter to apply this change to the sample page.

Now you want to change the customer number field properties.
3. Click the Fields tab on the Properties table.

This opens the field properties for the selected field in the list.

You want to change the field label. You also want to change this application so
it will be able to tell the user if there is a problem with the input data
submitted. If the program fails to find a customer record for the customer
number that was keyed into the input page, the program will send back a
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message id in the feedback parameter. This error message text contains a
substitution variable. You want to fill this substitution variable with the data
from the cnumber input field. To enable the wizard to generate the code for
this function you need to tell it that variable cnumber contains data for the
substitution variable in the message.

You will make this change using the Properties table.

To change a field label:

# Web Interaction : 1'
Design the Input Form
Specky the page properties and the input parameters that the generated \Web page vall expose to the user For input, 00@
Input paramaters: ﬂ
1% cnumber Maove up .
Customer Inquiry
Mowve down [
al Enter customer number:
Nong
_Property I —— [
Drata Type:
Tnput Style: Text
Input Choices: .
Siza 7
Mame in Session: cnumber
Restore from Session: False
Savee bo Session: False
Get Browser Info.:
-
i — L -
oge | Feks -

cgad;lum)”&ishlw

In the left pane of the Design the Input Form page, select cnumber.

Click the field beside the Label property, and type Enter customer number.
Click the field beside the Message ID property, and type CUS0001.

Press Enter.

A wbdpE

Note: Make sure to press Enter after making this entry.

CUS0001 is the message id that contains a substitution variable that will be
filled with the content of cnumber in case of an exception during the database
retrieval.

5. Click Next to advance to the next wizard page.

Exercise 4.11: Defining the output page content

Now you can specify what data should be displayed on the Output Web page
generated for you. In the right pane of the wizard you see a sample of the page
that will be generated. First, change the Input style of the output parameter
struc. CUSTNO. This will enable you to use customer number as an input
parameter to future features of your Web project.
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To define the output page:

& Web Interaction |
Design the Result Form
Specky the page propertiss and the output parameters that the genersted Wb page will display to the user s output. 00@
=l
[ave up
v | Result Form
Move down
Ealstruc.conrac SO [
Ml struc.crronE L <l 0
el struc crax None f CTUSTHA:
Halistruc.canon REPNO
Elalstruc.cormy ’
[l struc.ccounT CONTAC:
Eallstruc.czie CFHONE
Malstrue.czireo CEAT
[ alifeedback
CADDE.
CCITY:
CCOUNT:
_Property | value [ J| cZP
Label: CUSTRO CZIPLO:
o feedback
Input Choices:
T H 7
Mame in Session: CUSTHO
Save ba Session: False
E El
<k | o> [ Esh | cancel

1. Select struc. CUSTNO.
2. Click the Fields tab.
3. In the Properties table from the Input Style list, select Text.

By default all output parameters will be added to the Web page, but you don’t
want the data in the feedback parameter to be displayed.

Let’s go through the steps to erase the feedback parameter from the output

page.

Qutput parameters:

|

uc, CUSTNO

[ @istruc.cusTra
[ @'} struc.REPNO
[ @listruc.conTAC
[ @i struc.CPHONE
[ @i struc.cray

[ @istruc.canor
[ alistruc.ccmy
[ @istruc.ccounT
Ma istruc.CzIP

vl CZIPLO
Oalifeedback

Mave up

Mave down

l

Nong

4. In the left pane of the Design the Result Form, clear the feedback check box.
This will remove it from the Web page.

You will stay on this page to specify the error handling.
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Exercise 4.12: Specifying error handling
Now you can specify what should happen in case a customer number didn’t match
the customer numbers in your database.
1. In the left pane of the Design the Result Form, select the feedback variable.
You will see the properties for this variable in the Properties table.

1 _|alfeedback

_Property [ value |
Label: feedback.
Data Type: characten(z0)
Input Style: Label
Input Choices: e
Size: 20
Mame in Session: feedback.

Save to Session:
Message Indicator:

Page IFi_eIds ‘

2. Locate the Message Indicator heading in this Properties table.
3. Click the field beside the Message Indicator and set it to true.

This just tells the wizard that this parameter will contain an indication whether
the program call was successful or not.

The Advanced Message Handling dialog opens:

cﬁ: Advanced Message Handling j _)5]

é&ifv the value to indicate not to retrieve message text,
|0

(¥ Message text From the iSeries message file

W"—‘"\

WSSLABRx . |mmser )

" Message text from the properties file

Properties file I

| oK I Cancel I

In the Specify the value to indicate not to retrieve message text, type 0.
Leave the Message text from the iSeries message file radio button selected.
In the Library field, type WSSLABxx.

In the Message file field, type MYMSGF.

Click OK.

The message handling is defined.

© N o gk

Chapter 4. Module 4: Creating a Web application 41



Exercise 4.13: Enhancing the output page

Next you enhance the look of the Web page.

To enhance the output page:
1. Click the Page tab in the Properties table.

&b Web Interaction

Design the Result Form |
Specify the page properties and the output parameters that the genersted Web page will display to the user as output, 000 |
Output paramsters:

Ma/lstruc.custho

el struc.custig
[ lstruc. REPHD
Blalstruc.conmac
' lstruc.corone
[ fstruc.cras

[ a/lstruc.canon
' lstruc.ccamy

[ allstruc.coomr
Balstc.care
Eallstruc.caro
O allfeedback

Customer Details

il

Customer Detals
£ RGB {255, 255, 123}
RGE {0, 0, 255}

(9,128,54)

< Back | Hext > I Finish Cancel

2. Click the field beside the Page title and type Customer Details.

Click the field beside the Background Color and click the selection button on
the right side of the field.

The Color palette opens.
4. Select a light yellow from the Color palette.

20|

Custom colors:

Define Custom Colars >> I

oK | Cancel |

5. Click OK on the Color palette.

6. Click the field beside the Title Color and select Blue from the Color palette.
7. Click OK on the Color palette.
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8. Click the field beside the Field Color and select Dark Green from the Color
palette.

9. Click OK on the Color palette.
You notice the sample page gets updated as you choose different properties.

If you don’t like the suggested color choices, go ahead and create your own
design.

You need to modify the labels of the fields that show up on the output JSP.
10. Click the Fields tab.

11. Select each field under Output parameters, and for each one, change the
Label value to the values described in the table below:

4B Web Interaction B !L
Design the Result Form o |
Specify the and the output ters that the g Web page will display to the user & ouk
Specify the page at page wil display to put. @el
3|
e toves | Customer Details |
[ @ fstruc REPHG Mgve down |
Ea'lstruc. I—
E]:istrmé?"mm LI '
[ @/l strue. crae Hong | Ch ame
Elalstruc caotr L d Jumber
[Falstruc.cary :
Bl strue.coounr (ontact
'l struc C21P Phone Number
fetruc. .
@ ":'m:j:“o Fax Number
Labed:
Data Type:
Input Style: Text
Input Choices:
Size: 7
Name in Session: CUSTNO
Save bo Session: False
< Back | e |I Fanish I Cancel
CUSTNO Customer Number
CUSTNA Customer Name
REPNO Representative Number
CONTAC Contact
CPHONE Phone Number
CFAX Fax Number
CADDR Address
CCITY City
CCOUNT Country
CZIP Zip

12. In the left pane of the Design the Result Form page, clear the struc. CZIPLO
check box. You don’t need to display this variable.

13. Click Finish on the Design the Result Form page.

The Interaction wizard creates the necessary files for your application:
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* The file custInquiry.wit is created in the project. This file reflects the data
you entered on the pages of the Web Interaction wizard for the interaction
you identified as cust. To modify these settings, double-click on the file to
open the Web Interaction wizard.

The default package under the Java Source folder contains the java files
generated by the wizard.

e The classes folder under WebContent/WEB-INF contains the .class files that
were generated from the java files that were created by the wizard.

Exercise 4.15: Ensuring customer number field cannot be modified

Let’s make sure that the Customer Number field on your results.jsp page cannot be
modified.

To ensure the customer number field cannot be modified:

1. In the Project Navigator, expand your project then WebContent and locate
result.jsp.

2 o (£ :D: __z_';'la
=-(Z# webContent -
[#)- = META-INF
[#-{z=- theme
[+ = WEB-INF
- changePassword.jsp
@o errar, jsp
-15) inquiry.jsp

@o logon. jsp

- winklabsc:, peml

=gl Libraries

By custInguiry.wit Bt
Project Navigator |Galery | Struts Explorer

2. Right-click result.jsp.

Project I v X ) Welc
G oE =§='
- E-(Z# webContent -

#-{= META-INF

[+ = theme

{5 WEB-INF I

& changnnacmsnvd ion
B error.: New 4
inl GoTa

Open

st '}\ Libraries 5o
L%y custInguir Move...

Project Navigator | Ge Rename. ..

3. Click Open on the pop-up menu.
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This opens the result.jsp page on the Page Designer.

= 8 WebContent -

< & e
#- (= theme

#)-(Z= WEB-INF

@v changePassword. jsp Customer D‘

- errar.jsp
{8 inquiry.jsp
B logon.jsp

AT T rm AT T oA T P i T PO T T rm A T T rma T T

i%result label_Customer_Number

“struc_CUS"

‘i.] it d:lxx.r:cml 1eresult label_Representative ‘struc_REPI

= il Libraries so%resultJabel_Contact sstruc CON
\bﬁ custInguiry. wit - Boeesswsnnannnnnnnnnnrsnnnnssngooiirrnasnnrrnassdannnaanninnans

. E%r&sult.lahel Phone “struc_ CPHr
ProiectNawgatnr|Galery|5tmtsEprorer ............... P e e e e S, T

_ result label F ‘struc CFAZ
© swbi S el S A el

3 roresult labe struc_CAD

IWCLAWTEXTENTRY ~ e S B Lnpan

General | pata | Events | styles | DESiG""}&":B |Preview

Mame: Im - %sks(l ikerm)

Input type: ITe)d: j /”. | [t | Description | re... | 1n Folder [L.. |

Size: [?_ & The import java....  Pro... wintlabxxfd... ..

Initial state: ioabladd

Otientation:

4. Select the Text field of Customer Number in Page Designer.

Notice the Attributes view of that Text field appears in Page Designer.
5. Select the Read-only check box.

This prevents any modifications to the Customer Number.
6. Close Page Designer. Click Yes to save the changes.

Recap

Congratulations! You have completed Module 4: Creating a Web interaction. You
should know understand:

* The purpose of an interaction.

* How to invoke a Web interaction.

* How to specify input and output pages.

* How to define a program invocation and parameters.

* How to invoke a service program.

* How to define the program structure.

* How to add reference fields from DB2/400 to the program structure.
* How to add a structure as a parameter.

* How to add a feedback parameter.

* How to define the input page content.

* How to define the output page content.

* How to specify error handling.

* How to enhance the output page

* How to ensure the customer number field cannot be modified

Before you can test your Web application you have to create the iSeries program
containing the business logic to return data to your result page. You can write the
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logic with SEU if you wish. The next module guides you through using the
Remote System Explorer perspective to edit and compile your iSeries program.
Continue to Module 5: Adding the iSeries program to your Web application.
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Chapter 5. Module 5: Adding the iSeries program to your Web

application

In this module, you will learn how to add the iSeries program to your Web
application using the Remote System Explorer perspective. Remote System
Explorer provides a PDM like environment but with a GUI interface, and full
integration with all iSeries programmer tools in the Development Studio Client
workbench.

In order to add the iSeries program to your Web application, there are several
steps you will need to learn about and follow:

Understanding LPEX editor features
Opening the RSE perspective
Finding an iSeries source member
Editing an iSeries source member
Compiling an object.

Note: To access iSeries data and resources you will need to have a job description

setup and associated with your user profile on your iSeries system.

In order to accomplish these learning objectives, there are several steps that are
involved, including:

Exercise 5.1: Opening the RSE perspective

Exercise 5.2: Finding an iSeries source member in the RSE
Exercise 5.3: Editing an iSeries source member in the RSE
Exercise 5.4: Reviewing some LPEX Editor features
Exercise 5.5: Creating a PGM object with RPGIV

Exercise 5.6: Creating a SRVPGM object with RPGIV

The exercises in this module must be completed in order. Start with Exercise 5.1
when you are ready to begin.

Length of time:

This module will take approximately 15 minutes to complete.

Exercise 5.1: Opening the Remote System Explorer perspective

To open the Remote System Explorer perspective:

1. In the workbench, check whether you have the Remote System Explorer

perspective already open. Look for the icon in the left taskbar of the
workbench.

© Copyright IBM Corp. 2001, 2004
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2. If you see it click the @ RSE icon.

.

%5 Project Navigator v X
G E RS
= Z# wehContent a
(= META-INF

[+-{= theme

= WEB-INF

@r changePassword. jsp
@w Error.jsp

-8 inquiry.jsp

@w lagan.jsp

{i).l messages. js

- result.jsp

€4 wdt400br . is —
-~ E] wintlabx, peml
-l Libraries

By custInguiry.wit LI
Project Mavigator IGdIary | Struts Explorer

N e

3. Otherwise, select Window > Open Perspective > Remote System Explorer on
the workbench menu.

The Remote System Explorer perspective opens.

+2 Remote System Explorer - WebSphere Development Studio Client
Filz it Mavigate Search Project Run  Window Help

|S-HEe8]3-%-%-[|9|AMP[*c - -
A8 Remote Systems w X
¥@cs TR
A

8= Outline X

| © gl| i

E& Mew Connection
-8 Local
=8y s400a
=y s400a
.D.g, iSeties Objects
[+ g% iSeries Commands
[+ ol iSeries Jobs
[ Ty IFS Flles

Consols

Remote Systems | Team

] Properties v X
B 5
Property

- v
Connection status = 1K Ll—l
4| | ’|

Remote ... (Tasks iSeries T... |iSeries C... |iSeriesEr... |Consols |

Exercise 5.2: Finding an iSeries source member

You will see a list of servers in the Remote Systems view. Now you locate the
source you want to edit.
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To find an iSeries source member:

D eH a2

call i

-8 New Connection -

1]

&
i E :%:b “Work with libraries. ..
-2 Work with objects. ..
= :%:b ‘Wark with members. ..
: 2 Library list
i |'+_' Wl Q5vs.Mib.prod-sys
i E '}\ QSVS2 . *lib.prod-sys
© @il QHLPSYS.Hib.prod-sys
@il QUSRSYS *ib.prod-sys
| &M RSELABOL.Mib.test-cur
© @l RSELABOL.*iib.test-usr
- @l YARLABOL.Mib.test-usr
g wELe
<
5

Remote Systems | Team

1.

Expand your iSeries server. Use the same server that you have used to specify
the reference fields in the data structure.

Expand iSeries Objects.
Expand Library list. If prompted, type your user ID and password.

Look for WSSLABxx. If you do not see this library, then right-click Library list
and click Add Library List Entry on the pop-up menu. Type WSSLABXX in the
Additional Library field and click OK.

Expand the library WSSLABxx.

You will see all objects in this library.

Expand the source file QRPGLESRC.

Scroll down to the source members in the expanded list.

Exercise 5.3: Editing a source member

Two shell source members are prepared for you to use. Depending on whether you
specified that you want to work with a program, or a procedure in a service
program, you need to select a different member.

To edit a source member:

1.
2.

For a program call, right-click member GETDATA.
For a service program call, right-click member GETDATAS.
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3. Select Open with > Remote Systems LPEX Editor on the pop-up menu.

w 3 || i ]welc
SWTEXTEM

[ ﬁ PRODINY *file.pf-dta |
=[5 PRODLIST *file.pf-dta Iﬁ sess
i[5 PRODSHOW *File.pf-dta
& PRODUCT . *file.pf-dta

|© &3

-] PRODUCTIF *file.If C[
& 5 QCBLLESRC. *file.pf-src
=2y QDDSSRC. Hfile. pF-sre D
(3

= E) QRPGLESRC *file.pf-src
-y GETDASOL.rpgle

[y GETDASOLZ.rpgle g

[y GETDATA.rpgle J—’—
i) wn—.- A Desian ‘-'i
3
LMy GETDE GoTo

ith »
§85 CODE Editor Browse Wit

]
- &% WFAI XY, Ef Rename

Remate Systems ‘Team Copy
=] Properties i + Move
Property I Walus 8 Delete
fiktribke (= =Tl
N Verify
Open new view Werifv (Proamnty

The Editor window opens and you are ready to write your program.

Tip: You can also double-click on a member to bring up the Remote Systems
LPEX editor.

For the two different choices provided, you need to go to the correct exercise:

¢ Write a regular RPG program — Exercise 5.5: Creating the *PGM object using
RPG

* Write an RPG Service Program — Exercise 5.6: Creating the *SRVPGM using
RPG
Before you do that, if you have not worked with the Remote Systems LPEX
editor you might want to go through Exercise 5.4: Reviewing Remote Systems
LPEX Editor Features.

Exercise 5.4: Reviewing Remote System LPEX Editor features

Before you start, here are some useful tips on using the LPEX editor. Let’s look at
some of the features of the LPEX editor, so you can later easily find your way
around and use them:

* ALT+L marks a line.

* ALT+U unmarks selection

e ALT+D deletes a selected text
* ALT+C copies selected text

* ALT+M moves selected text

* Press Enter to insert a new line

Highlighting specification fields
The LPEX editor highlights the Tokens (specification fields) of your RPG program
source, providing a separate color for each, improving readability. When you make
changes to a line, the token colors get updated only after you move your cursor off
the line.
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To see how token highlighting works:

1. Move the cursor to a Calculation statement.

2. Position the cursor to column 7 (right next to the 'C’).
3. Type an asterisk ().

4. Move the cursor off the line and watch what happens.

The line where the asterisk (*) was typed has become a comment line and its
color changes accordingly.

¢§ b4 |
Fow 16 Colurn & Inserc 4 changes.

e . R P P P SN
000800 FCUSTOMLS IF E K DISK :I
aooso0 ®
001000 *Input parameter from Web page
001100 DCustnoi E] 14l
001zoo0 * Data structure to specify output stru
001300 I CSTRUC E D3 exi
001400 I feedback = 20
001500 o : ” s
001600 G" parm i
Q01700 ] T
001800 (] parm
001900 ] parm
00z 100 ot eval feedback=7}
oozzoo ] eval forward=‘*h,
ooz 400 c* Insert code here -—-——-—-——- > v
«| | L|J
| A

5. Move the cursor back to column 7 and remove the asterisk (*).
6. Move the cursor off that line of code and the statement is tokenized.

The token highlighting changes to reflect that this is a non-commented 'C’
specification.

Displaying types of lines
Using the LPEX editor, it is possible to have only particular types of source lines
displayed at a time.

To display types of lines:
1. Right-click anywhere in the editor window.
2. Click Filter view on the pop-up menu.
The menu items list the types of line selections that can be made.
3. Click Comments.
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The Editor window now contains only those RPG statements that are

comments.

¢§ )<|

Row 20 Columm 25 Inserc 5 changes.

B T TTT T T Y DI

000200 * 2|
000300 * Samiple RPGIV progrswn to access file C
000400 = Used in WDT hands on LAB
ooosoo * Created by Claus Weiss
ooos00  *

B 000700 * F spec for file CUSTOML3 keyed by custom
ooo9oo *

001000 *Input parameter from Webh page
001200 * Data Structure to Specify ocutput sStructu

002100 o~ eval feedback=*bla
002400 c* Insert code here —----——=——— >
003100 C* EVAL FEEDBACK='CUS
003600 C* EVAL FEEDBACK='0'
004600 o™ Done with inserting code --———-——- 3 —
i ooa7o0 + =
Kl | I3
I I

4. Right-click anywhere in the editor window.
5. Click Show all on the pop-up menu.

| ey

Row 2 Column 15 Insertc 5 changes.
B T - T B R TEL TR RS
Ddozoo  © -]
000300 New > ogram to access file C
000400 % context ids on LAE
ooosoo = Prompt s Weiss
E gggggg i SS::;:)(FCO?:E:E:: ISTOML3 keyved by custom
[ [ul=Tu]u Y
001000 +*. cCut pro Webh pade
o0izoo o« Copy specify output sStructu
D0Z100 o+ Paste val feedback=*hla
AEZERE C* e ——————————— >
003100 c+  Select line VAL FEEDBACK='CUS
003600 Cc+  Select character VAL FEEDBLCE='0D"
004600 ¢+ Select rectangle ing code —-——--—--——-- > .
[ oo4700 +  Selected » <
LI Deselect | _pl_l

o L

All statements types are displayed. In addition, the choices in the popup menu
can be used to include only control specifications, user subroutines, and
procedure and others. The Filter Selection option under the Selected option in
the Edit menu pull down will allow the selection of only those lines containing
a particular selected character string.

Checking the syntax of a file

Syntax checking is available for RPG code, and by default will be active. The
syntax of the RPG code is checked automatically when a change is made to a line,
and the cursor is moved off the line.

When errors are found, they are displayed following the statement with the error.
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Keeping track of columns in a specification line

The format line is at the top of the editor window, just above the first statement. A
format line is used to help keep track of the columns in a particular specification
line. The content of the format line can vary to reflect the particular type of
specification being keyed such as F specs, C specs, D specs and so on.

To display a format line:

1. Clicking a line or use the arrow keys and click the left mouse button to make a
line active.
The format line gets updated as a line gets focus.
You can move the cursor right or left with the arrow keys to go from character
to character, or with the Tab key to go from field to field. An indicator on the
format line moves with the cursor to show in which column the cursor is
positioned.

t!;. b4 |

Fow 11 Columrn 44 wIerc 5 changes.
JsFrom+++To/ L+++1ID wur ds+++ b
000200 |
000300 progrstn To aoCess le CUSTOML3

000400 a&nds on LAB

0005001aus Weiss

000&00

000700 CUSTOMLI keyed by stomer nunber

ooogo00 E DISE p=
oo0osoo

001000Erom Web page

001100z e (CUSTNO)

001200-0 specify output 3 cture to return to Servl
00130005 exthname (customld icustomll)
001400= 20

001500 plistc

001600 parn custnoi -
o e

I
| )

You can select a format line for any specification you want.
2. Click Source from the Editor menu.
3. Click Select Format Line on the pop-up menu.

The Format Line Selection window opens.

b Format Line

Select Format line: | gEfelEyligs

Now you can start and create the RPG program or service program.
4. Click OK.

Exercise 5.5: Creating a *PGM object with RPG

To make it easier for you, most of the RPG source is already prepared for you. You
have already opened the correct source member GETDATA in the previous exercise
using the Remote Systems view.
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Read through the source. It contains an F spec to access file CUSTOML3, which
contains the customer data keyed by customer number. The D specs defines the
data structure CSTRUC that you pass back to your Web page and the CUSTNOI

variable that gets passed from the Web page to this program. As well the Feedback

variable is defined as a 20 length character field.

The Entry parameter list is defined as:

» CUSTNOI field (this is the input parameter).

* CSTRUC structure (this the data structure for the customer output data).
* Feedback field to indicate no success for file access.

The code you have to write here, fetches a customer record by chaining to the
file with the CUSTNOI that gets passed into the program.

To create a *PGM object with RPG:
1. Add the code to get the customer record and check whether the chain was

successful.

CLONO1Factorl+++++++Opcode (E) +Factor2+++++++Resul t++++++++Len++D+Hi LoEq
C CUSTNOI CHAIN CUSTOML3 5050
C

C IF *IN50

C EVAL FEEDBACK="'CUS0001 ' + CUSTNOI

C ELSE

C EVAL FEEDBACK='0"

C ENDIF

2. Your coding is complete, so let’s create the program.

3. Click the Save icon on the workbench toolbar to save the member.
4. Click the X in the Editor window title bar to close the member.

+ ] Welcome [ J*wintlabsxDiagram.gph IE’*"&WR'ED |m ®

Row 1 Columm 1 Eeplace

Be careful not to click the X on the workbench window title bar.

|@ 6| m H » | A}  Openwih v
ﬁ' Brovese With 3
[ — dir

% =§§ Sé‘i b o B | b} < CB"IEII’I‘IE

@ [ l:j CUSTON opy

-] cusTow #» Move
[ EVFEVEM g pelete
- INVPRIN
-[F PrODDT  Verify

-[3 PRODIN'  Verify (Prompt)

P -3 PrODUE  Compile »
v B CRTBMNDRFG... Compile (Prompt)
: User Actions [ 3

=@ E-F-E

Epr CRTRPGMOD...
Add To iSeries Project...
T work with Compile Commands... Make Available Offline

] T omowaE

- GETC Compare YWith

-~y GETl  Properties

..
-0 prrere
-0y GETDATAS.rpgle
G GFTRSSO rmale LI

5. In the Remote Systems view, right-click the GETDATA member in source file
QRPGLESRC and click Compile (Prompt) > CRTBNDRPG on the pop-up
menu.

ILE RPG e-business application



The Create Bound RPG Program (CRTBNDRPG) window opens:

&P Create Bound RPG Program (CRTBNDRPG) _ x|

Program: GETDATA =i MName =

Library: WSSLABOL B MName
Source file: QRPGLESRC hhd Mame, QRPGLESRC

Library: WSSLABOL hd Mame
Source member: GETDATA A | Name
Generation severity level: 10 0-20
Text 'description': *SRCMERTXT j Character value. ..
Default activation group: *YES A

Advanced Parameters
Compiler options: I = I
*EVENTF emove(B) e
Move up |
Move down |
i
Debugaing views: c ) j
[~ Advanced () [ all parameters(y) [~ Keywords(Z)
CRTENDRPG PGM{WSSLABO1]GETDATA) SRCFILE('WSSLABD1 JQRPGLESRC) SRCMBR{GETDATA) OPTIOM({*EVENTF) ;I
DEGYIEW(*ALL)
oK | Restore defauts cancel |
I - |

6. In the Debugging views list, select *ALL
7. Click OK to start to compile.

After compile, the error list view is shown, listing all compile errors. You may
see only information and warning messages which means your compile was
completed and the program object was created.

Commands Log

CRTBNDRPG PGM{W/SSLABO1JGETDATA) SRCFILE(WSSLABO1/QRPGLESRC) SRCMBR{GETDATA)
OPTION(*EVENTF) DEGYIEW(*ALL)

Program GETDATA placed in library WSSLABOL. 00 highest severity, Created on 02/16{04 at
13:42:01.

Cause . ....: Program GETDATA was successfully created in library WSSLABO1, The highest
message severity that resulted was 00, The program creation date and time are 02/16/04 and
13:42:01.

&l
Command INarmd ﬂ I ﬂ Prompt... | E'_unl
Remiote System Details |Tasl-<s |iSeties Table VieW, iSeries Commands Log L&eries Error List

Click the iSeries Commands Log tab to check that the compile was successful.
This log shows the Remote System Explorer job messages.

Now you are ready to run your Web application. Go to Module 6: Running the
Web Application and skip Exercise 5.6: Creating a *SRVPGM with RPGIV.
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If you get a message that there are errors in your program, go through the edit
compile fix cycle.

Fixing errors

In the error list view, check the errors:

1. Double-click the error.

This positions the cursor in the Editor window on the statement that is wrong.
Fix all errors.

Save the source member.

Go back to the Remote Systems view.

Right-click the member to run the CRTBNDRPG command.

Continue this cycle until you get a clean compile then go to Module 6: Running
the Web Application.

S

Exercise 5.6: Creating *SRVPGM with RPG

56

To make it easier for you most of the RPG source is already prepared for you. You
have already opened the correct source member GETDATAS in the previous
exercise using the Remote Systems view. Read through the source. It contains an F
spec to access file CUSTOML3 which contains the customer data keyed by
customer number. The D specs define the data structure CSTRUC that gets passed
back to your Web page and the CUSTNOI variable that gets passed from the Web
page to this program. Also variable FEEDBACK is defined as 20 characters, to
return message id and customer number in case the customer record was not
found.

The prototype for procedure getrecord with the parameters is defined as the:
e CUSTNOI field (this is the input parameter)

* CSTRUC structure (this is the data structure for customer data)

* FEEDBACK field (returns error or success)

Note: The external name is case sensitive. It has to match exactly what you
specified in the Web Interaction wizard.

The procedure interface defines the parameters in the same way as the prototype.
Inside the procedure after the procedure interface you need to add the RPG code.

To add the RPG code:
1. CLON®1Factorl+++++++0Opcode (E)+Factor2+++++++Resul t++++++++Len++D+HiLoEq

C CUSTNOI CHAIN CUSTOML3 5050
C

C IF not *IN50

C EVAL custl=cstruc

C EVAL FEEDBACK='0"

C ELSE

C EVAL FEEDBACK="'CUS0Q001 '+ CUSTNOI

C ENDIF

2. You do a CHAIN to the database and move the database fields to the local
procedure structure. If the database access fails, move the MSGID and
Customer number to the FEEDBACK variable.

Your coding is complete, so let’s create the service program module.

To create the service program module:
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1. Click the Save icon on the workbench toolbar to save the member.
2. Click X in the Editor window title bar to close the member.

| ] Welcome ﬁlmwinthbxxbiagram,. |_‘ “Loresult.jsp m ®

Fow 1 Columrn 1 Replace
B....... ToveadieenZiieatiia3oe it 4.,

Be careful, don’t click the X on the workbench window title bar.

In the Remote Systems view, right-click GETDATAS member in QRPGLESRC

and select Compile (Prompt) > CRTRPGMOD on the pop-up menu.

= [ B
E =|§ g§j 5 7 | ){ <= Row 1
@ @] QDOSSRC, *file.pf-src ;l
o= |: E] QRPGLESRC. *file.pf-src lzezae
[y GETDASOL.rpgle sl
-y GETDASOLZ.rpgle gg:ggg
-0y GETDATA.rpale
o G | oosoo”
-0y GETDSSOL.p  GoTo o
r [i' QSYSPRT. *file.pf- N
5)-[F SALES.*file,pf-dt: :mn Nh:r.'m 5
R waSSCR Mile.sa D oree
&y wrALBXX *file.sa g pename
h ABC. *menu.dspf
(&) STRCODE.*usrsps 5] Copy
- User libraries + Move
ﬁi{ iSeries Commands
|
& iSeries Jobs Ll
.:F« 175 Files Verify
s Verify (Prompt)
Remote Systems | Team Compile »
Ep) CRTENDRPG. .
B. CRTRPG
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The Create RPG Module (CRTRPGMOD) opens:

4P Create RPG Module (CRTRPGMOD) _ x|
Module: GETDATAS =] Mame =
Library: WSSLABO1 = Name
Source file: QRPGLESRC Jlad Mame, QRPGLESRC
Library: WSSLABOD1 Jlad Name
Source member: GETDATAS v | Mame
Generation severity level: 10 0-20
Text 'description': *SRCMBRTXT ‘:] Character value...
Advanced Parameters
Compiler options: I - | Add I
*EVENTF Aemove
e
Debugging views: ( FALL
[~ Advanced () [ all parameters(y) [~ Keywords(Z)
CRTRPGMOD MODULE(WSSLABO L /GETDATAS) SRCFILE(WSSLABD1 /QRPGLESRC) SRCMBR{GETDATAS) OPTION(*EVENTF) _ﬂ
DEGYIEW(*ALL)

oK | Restore defauts cancel |

I - |

4. In the Debugging views list, select *ALL
5. Click OK to submit the command.

After the compile the error list view is shown, listing all compile errors. You
may only see information and warning messages that means your compile was
completed and the program module was created.

Cornmands Log

SRCMER(GETDATAS) OPTION{*EVENTF) DBGVIEW(*ALL) ﬂ
Module GETDATAS placed in library WSSLABOL. 10 highest severity. Created on

02/16/04 at 14:23:02,

Cause . ....: Module GETDATAS was successfully created in library WSSLABOL. The
highest message severity that resulted was 10, The module creation date and time are
02/16/04 and 14:23:02,

=

Command INarma1 ﬂ I ﬂ Prompt. ..

——— ——
Remate System Details |Tasl-<s [iSeties Table Vier[é&ies Commands Lo eries Error Lisk

Click the iSeries Commands Log tab to check if the compile was successful.
This log shows the Remote System Explorer job messages. Now you are ready
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to create a Service Program. Go to the section Creating a service program. If
you get a message that there have been errors found in your program, go
through the edit compile fix cycle.

Fixing errors
In the error list view, check the errors:

1.

o g s wN

Double-click on the error.

This positions the cursor in the Editor window on the statement that is wrong.
Fix all errors.

Save the source member.

Go back to the Remote Systems view.

Right-click the member to run the CRTRPGMOD command.

Continue this cycle until you get a clean compile then proceed to create the
service program.

Creating a service program

To create a service program:

1.

In the Remote Systems view find the GETDATAS module in library
WSSLABxx.

[+ [#] GETDSSOLC . *pgm.chlle

[+ [2] READDTAQ.*pam.rpgle

- [F] WRTDTAQ. *pgm.rpgle

£ ;Q GETDATASC. *srvpgm. cblle

53 hg GETDSSOL, *srvpom.rpgle

[+ p2] ORDENTR. *srvpgm.rpale

- &) GETDATA. *module

= )

#- 4§ GETDATAS

& &) GETDSSOL F ghow in Table

[l 4] SLTPARTR

[ CELDIAL* oy pename

[ INVMSGF.”

= [ MYMSGF.* 52 Copy

- VRPGMSGF I Past=

@ O Ausack o

-5 ALLSALES,

[y appsourc ¥ Delete
i (0] BYREGION

Remote Systems |Tearn

Go To 3

Move

Note: If you don’t see the module, right-click library WSSLABxx and select
Refresh.

Right-click GETDATAS and click Create > Service Program on the pop-up
menu.
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The Create Service Program (CRTSRVPGM) window opens

4P Create Service Program (CRTSRYPGM)

x|
Service program: GETDATAS MName =
Library: WSSLABD1 -1 Name
Moduls: | Mame, generic*
Library: "I Ad Mame
[ iD1/GETDATAS
A
Export: C *HLL =
Export source file: QSRYSRC ha Mame, QSRYSRC
Library: *LIBL ¥ Mame
Export source member: *SRYPGM 'I MName
Text ‘description’: *ELAMNK :] Character valus
™ Advanced (L) [~ allparameters ™ Keywords
CRTSRYPGM SRYPGM{WSSLABOL /GETDATAS) MODULE('WSSLABO1 /GETDATAS) EXPORT(*ALL) ;I
oK | Restore defauts cancel |
I - |

3. In the Export list, select *ALL.
4, Click OK.

Check the command log to see that the Service program was

You should see a message that the Service program was created.

L iseries Commands Log g v x
s400a |

CRTSRYPGM SRYPGEM{WSSLABD1{GETDATAS) MODULE(WSSLAEOL /GETDATAS) d

EXPORT{*ALL)

Service program GETDATAS created in library WSSLABO1.

Cause ... ..: Service program GETDATAS was successfully created in library

WSSLABOL, Recovery . .. Service program creation was successful,

=
Command INarma1 ﬂ I ﬂ Prompt.,. |
——
Remiote System Details |Tasl-<s |iSeties Table Yiew ﬁ éries Commands Logsmes Error Lisk

Finally you are ready to run your Web application.
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Recap

Congratulations! You have completed Module 5: Adding the iSeries program to
your Web application. You should now understand:

LPEX editor features

How to open the Remote System Explorer perspective
How to find an iSeries source member

How to edit an iSeries source member

How to compile a program object or a service program object

Now that you have created a program object or service program object continue to
Module 6: Running the Web application.
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Chapter 6. Module 6: Running the Web application

In this module you learn how to test the Web application locally without
deploying the files in the Web project to the host server. Testing your Web
application locally includes using the iSeries Web Tools Run-time Configuration
wizard to specify the authentication and run-time values for every host program or
procedure call made by any Web interaction in the Web project. This is something
you have already done in Exercise 2.4 and running your Web application in the
WebSphere test environment.

In order to run the Web application, there are several steps you will need to learn
about and follow:

* Opening the Web perspective and finding the Web application
* Running the Web application in the WebSphere test environment

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Exercise 6.1: Opening the Web perspective
* Exercise 6.2: Finding the Web application
* Exercise 6.3: Selecting the Run on Server option

Note: To access iSeries data and resources you will need to have a job description
setup and associated with your user profile on your iSeries system.

The exercises in this module must be completed in order. Start with Exercise 6.1
when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Exercise 6.1: Opening the Web perspective

To open the Web perspective:

1. Click the Web perspective @ icon, on the left taskbar of the workbench.

@Remute Systen

File Edt Mavigate
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2. If there is no Web perspective icon, select Window > Open Perspective > Web
on the workbench menu.

Exercise 6.2:

To find the Web application:

Finding the Web application

1. In the Project Navigator, expand your project wintlabxx if it is not already
expanded.

2. Expand the WebContent folder if it is not already expanded.

Exercise 6.3:

64

Selecting the run on server option

To test your application locally using the WebSphere test environment:

1. Right-click inquiry;jsp and click Run on Server on the pop-up menu.
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You will see a message to select the Server to run in the Test Environment:

&P server Selection x|

server selection

Select which server to launch,

" Use an existing server

Server | Status

Status:

% Create a new server

Folder: I Servers ﬂ

Server bype:

1] Test Environment
Te 4.0

3 C@ Apache Tomcat version 4.1

[ f:%: Apache Tomcat version 4.0

EE? Apache Tomcat version 3.2

[+ (23 Other

Description: Runs JZEE projects out of the workspace on the local test environment.

@et server as project default (do not prompt)

<ok | met» |[ Finish | cancel |

2. Make sure Test Environment is selected in the Server type list.
3. Select the Set server as project default (do not prompt) check box.
4. Click Finish to configure and launch the server.

After the WebSphere server has started, your Web application input page will
display in the workbench browser.

+ ] Welcome W X |

Ihttp:,l',l'lclcahclst:QDBDIwintlabxx,l'hquiy.isp ﬂ °| o @

Customer Inquiry

Enter customer number; 0010100
Reset
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5. Type 0010100 as the Customer Number.
6. Click Submit.
This launches the generated output or result page.
If you see a Page not found error, go to the Servers view.

I

4 Disconnect
2 Publish
Switch Configuration r

Restart Project »

g Add and remove projects...

Run universal test client

Sphere v5,0 Tesk -

Restart universal test client b2 .
Servers 5 F OF o8 17 B
il Rum administrative consale > K % ¢ @ 5 53 x
| Server @ Create babl dzta sources ] Server State

7. Restart the Server instance.

Then go back and try the Run on Server option again; the Server sometimes
needs to be restarted to pick up the changes. You will see the Result page
with customer data appearing in the workbench browser.

+ ] Welcome w X |

Ihttp:,l',l'lclcahclst:QJJSD,I‘wintlabxx.fl:ustlnquiry.do ﬂ -] | F o5

Customer Details
Customer Number: Q010100

Customer Name: Meridien Electronics Limited
Representative Number: 43443

Contact: Alfredo Bayonne

FPhone Number: 206-865-4027

Fax Number: 206-865-4037

Address: 10423 S E. 30th Place

City: Bellevue, WA

Country: USA.

Zip: 98007

Submit | Reset

Dane

Next, test the message handling:

8. Click the @ Back button in the browser to get back to the first page.
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9. Enter a wrong customer number, for example, 9999.

T |

|http:,f.fhcall'mt:QOBGIMntIabxx.finquirv.jsp j > | oo

Customer Inquiry

Enter customer number: {9999
Reset

Done

10. Click Submit.

An error message appears.

|http:.f.fbcalhost:QOBDIMntIabxinmuiry.jsp j ° S @ @

Customer Inquiry

Enter customer number.; d| CL
Reset

—

This capability is generated by the Web Interaction wizard. Remember that
you specified something for the feedback field; you specified the message file
to be accessed if the feedback field contains a non 0 value; in this case the
feedback parameter will contain the message ID to be used for the error
message.

Recap

Congratulations! You have completed Module 6: Running the Web application. You
should now understand:

* How to open the Web perspective
* How to find the Web application
* How to run the Web application

Now that you have run your Web application continue to Module 7: Adding Error
page to your Web application.
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Chapter 7. Module 7: Adding an error page

In this module, you will learn how to create an informative error page for when a
customer enters an incorrect customer number. This way, the customer won't just

be given an error message, but will have a more informative and helpful response
from the Web Application, which is completely customizable.

In order to add error control to the customer inquiry Web application, there are
several steps you will need to learn about and follow:

* Using Page Designer to add a new error page.
* Using the Web Interaction wizard to add the error page.

* Using the RSE perspective to modify the program or service program to call the
error page.

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Exercise 7.1: Creating the flow control page

* Exercise 7.2: Modifying your Web interaction

* Exercise 7.3: Modifying the RPG to implement flow control
* Exercise 7.4: Creating an RPG program (for GETDATA)

* Exercise 7.5: Creating a service program (for GETDATAS)

* Exercise 7.6: Testing the new error page

Exercise 7.1: Creating the flow control page

First we need to create the error page using Page Designer.

To create the error page:

1. In the Web Perspective, expand your project and drill down to the
WebContent folder if not already expanded.

= T@ wintlaboo =
- B web site Configuration

| 4% Web Deployment Descriptor
. @@ JavaSource

SRF} /=t Cop—-"o » .
L (e MET I =Y Project...
B ther 010 -
 mgswe GoTo b = Folder
. B char__ Openn New Window &N HTMLIXHTML File
) g oeas ) CoPY B° J5P File
M lage  FEste €3% Javascript File
Sy mes DR ) c5 Fil
& e
- res. MEVE: . # .

2. Right-click the WebContent folder and click New > JSP on the pop-up menu.
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The New JSP File page opens:

&p New J5P File : x|
Mew ISP File
Specify a name and location For the new J5P file, @
Folder: | Jwintlabxs/WwebContent Browise. .. |
i ———
File Marne: Q RecordNatFoi.l-rp
.
Markup Language: |HTML El
Options: I™ Create as 15P Fragment
[" Use %ML Style Syntax
Madel: ’None

Generate a new blank JSP page.

I 3 K

I” Configure advanced options

<Back [ x> || Fish | Cancel

3. In the File Name field, type RecordNotFound.
4. Click Finish.
The Page Designer automatically opens.
Your window will look like this:

R x|

RecordNotFound.jsp - RecordNotFound. jsp El - | Boov + | standard ~

IPlace content here.

Design | Source | Preview
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10.
11.

12.
13.

14.

15.

16.

Click on the words "Place content here.” and change it to something like
Sorry, there is no record for that customer number.

Press Enter.

Type Please check the number and try again.

Highlight the words try again and right-click.

Select Insert Link on the pop-up menu.

The Insert Link window opens.

Click Browse next to the URL field.

Click File on the pop-up menu.
The File Selection window opens:

b File Selection

Select a file:

~ioi x|

=) winklabc
[El-{z= WebContent

- META-INF
-z theme
¥ (3 WEB-INF
e fd Messages.js
€4 wdt400br js
?j changePassword. jsp

i =inquiry. jsp

i) logon.jsp
RecordiotFound. jsp
‘3_{ result.jsp
e[ wintlaboc,peml

[ o |

Cancel I

Select inquiry.jsp.

Click OK on the File Selection window.
The Insert Link window appears with the URL field updated.

Click OK on the Insert Link dialog.

You have completed creating the flow control page.

Save the file.

You could spend more time customizing this page, but for the purpose of this

exercise you will leave the page as is.

Close Page Designer.

Exercise 7.2: Modifying your Web interaction

To modify the Web interaction:

1. Expand your project wintlabxx if not already expanded.
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on the pop-up menu:

£ K &
- error.jsp -
?\_,:&inqury.jsp
-'__gylogm.jsp
,&d messages.js

2% RecordMotFound. jsp
ot

result,jsp

<y wdt40hr is
] wintlak  New ¢
-y Libraries GoTo ¢
L, open

- wintlaboee
27 wintlabexC
-6 wintlabx=EAR ) Copy

Paste

Text Editor

&= -

The Web Interaction wizard opens:

The name and location of your Web interaction are already specified.
Click Next to add a new output page.

B Web Interaction

Specily the Input and Dutput Pages for your Web Interaction

You can use previousty designed input and output pages fior this Wb interaction or you can heave the wizard generate them.

Paps preview
I
O Genwrateir
& Lise input pages:
nquiry. fsp Add... |
T |

<Back tew> [ Fosh

Cancel

2. Right-click custInquiry.wit and select Open With > Web Interaction Wizard

4. Next to the resultjsp section, click Add.
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The Output JSP window opens:

b Output ISP

Choose output J5Ps
== WebContent

- @' RecordiotFound. jsp
- changePassword.jsp
= @' error.jsp

~18) inquiry.jsp

@ logon.jsp

- result.jsp

| oK I Cancel

5. Expand WebContent.
6. Select RecordNotFound.jsp.
Click OK to add the new output page.

B Web Interaction

Specily the Input and Dutput Pages for your Web Interaction

You can use previousty designed input and output pages for this Wb interaction or you can have the wizard generate them.

€ Genprate inp
= Lise input pages:
nquiry. 5p

€ Generate sutpat 15
& Lge output pages:

resuk. 5p
ReecordotFound.jsp

<Back |®| rish Cancel
i S—

8. Click Next in the Web Interaction wizard.

You will re-use the Feedback parameter to control which page the Web
Interaction will send next after it performs its action; the result.jsp or the
RecordNotFound.jsp. So you don’t have to add another parameter or change
the parameters, you just change the values the feedback parameter returns
depending on whether a customer record was found or not found.

Since you don’t need to define the program interface:
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9. Click Next.
This opens the Input Parameters page.
10. Since you don’t need to change any input parameters.
11. Click Next again.
This opens the Output Parameters page.

|
Map and Link the Dutput Parameters to the Dutput Fields
Link the parameters in your program to the fiskds on your Web page. The value of the output paramster in your program is passed to the comesponding output fields on
your Web page,
w paramebers: ik I Urfnk I Output page fields:
5 strue CUSTNO @) resut.jsp
i struc.cUsTNA Parameters | Fiekds | @) fRecordiotFound.jsp
€7 struc RESNOD struc, CUSTNG result jsp-struc_CUS...
C shruc, CUSTHA result, jep-struc_CUS. ..
fﬁmu:.CONIM SArUCREPND resul. jsp-struc_REPNG
i sAruc, CPHORE ArucCONTAC  resul jspestruc_CON...
4 strue. CRAX struc, CPHONE result jsp-struc_CFH. ..
5 struc CADDR struc CRAX result jsp-struc_CFAX
0 struc. CCITY struc. CADDR result, jsp-strc_CADDR
struc, CCTY result jop-struc_CCITY
€t Aruc. CCOLNT struc. COOUNT result. jsp-struc_CC0...
¥ struc. CZIP e, CZIP result, jep-struc_CZIP
allstruc.czIPLo
allfeedback
_Property | vahe l
DataType:  characten(20) _Property [ value
<pack | weis [T Emeh | caneel |

12. Select feedback under the Output Parameters list.

13. Change the Message Indicator property to false. Select feedback under the
Output Parameters list again.
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14.

15.

16.
17.
18.
19.
20.
21.

Now a Flow controller property is added to the Properties table.

Output parameters:

4 struc, CUSTHO
€ struc, CUSTNA
4 struc,REPNO
4 struc, CONTAC
4 struc, CPHONE
4 struc CRAY
4 struc. CADDR
4 struc, CCITY
4 struc, CCOUNT
4 struc,CZIP
alistruc.czIPLO
| feedback

Property | Value
Data Type: characker(20)
Mame in Session: feedback
YR Lo SEssion: false
false =
esTage Mhalcator: false

Change the Flow Controller property to true.
The Flow Control Specification dialog opens.

cﬁ: Flow Control Specification

E iOutputJSP : I

0 result.jsp
CLS000 Delete

/RecordiotFound. jsp

Mave up

Move down

i |

(DI

g

Click New.

This creates a new flow condition. The default page is result.jsp.
The value 0 is already in the Value field for the result.jsp.

Click New to create a new flow condition.

Double-click the Output JSP field to change the page.

Select RecordNotFound.jsp.

Type CUS0001 in the Value field for /RecordNotFound.jsp.

Click OK.

This will set the flow control such that if the value of Feedback is '0’, then the
program will output the customer information to the result;jsp page and
display it. However, if the customer number doesn’t exist in the database, the
Feedback value will be "CUS0001", and instead of displaying a message near
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the input field, it will show the user the RecordNotFound.jsp page for a more
helpful response. After modifying the Web Interaction, you will need to
modify your RPG program to remove the customer number from the
parameter if a record is not found.

22. Click Finish on the Output Parameters page to apply your changes to the

Web Interaction.

B Web Interaction

Map and Link the Dutput Parameters bo the Output Fields
Lirk the parameters in your program to the fields on your Web page. The value of the output parameter in your program is passed to the corresponding output fislds on e 1
your Web page. |
Cutpait parameters: Lin I Ui I Cutput page fiekds:
2 struc. CUSTNO 5@ resuk.p
€ shruc CUSTNA Farameters [ Fiekds | @) RecordiotFound.fsp
4 struc REFND struc, CUSTHG result fsp-struc_CUS,..
3 struc, CUSTHA result jsp-struc_OUS. ..
3 struc. CONTA
"f'”‘ CONTAC struc REPNO result. jsp-struc_REPNG
A struc.CPHONE struc, CONTAC result fsp-struc_CON...
¥ struc. CFAZ struc, CPHONE result jsp-struc_CPH. ..
€ struc CADDR struc, CFAK result. jsp-struc_OFAN
2 e [ JEp e
85 struc. CCOLMT Sroc COOUNT  resub fsp-struc_CCO...
i struc. CIIP struc, CZIP result jspstruc_CZIP
allstruc.caimo
allfeachac:
Property [ vabe
DataType:  character(7) _Property | value
Name in Sessi,.. CUSTNO
Save to Sessi... False
Flow Controlles:  False
Message Indi... False

< Back | Hext > I- Cancel |

You may see a message indicating that the server needs to be restarted. Click
Yes to do so.

Exercise 7.3: Modifying the RPG to implement flow control

You will now modify the RPG code to change the values returned in the Feedback
parameter.

To modify the RPG code:
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1. Look for the Remote System Explorer icon T in the left taskbar of the
workbench.

&P Web - WebSphere Development Studio Client

File Edit Mavigate Search Project Run  ClearCs
| -s,.-'—-"-1| X [[m[a8-]]
J-;-? ® - UIJ@\@\I Bl KL

: @c error.jsp -
L2 inguiry.jsp
; @f lagon.jsp
i 37.1 messages.js
; @r RecordMotFound. jsp
: @r resulk.jsp
€y wdt400br js
o [2] wintlabsee, peral
j ']\ Libraries

: intlaboce. mpcml
LT wintlabeseDiagram. aph
[+ 158 wintlabxxEAR I

Project Mavigator |Gdlery | Struts Explorer

2. If you see it, click the Remote System Explorer icon.

3. Otherwise, select Window > Open Perspective > Remote System Explorer on
the workbench menu.

The Remote System Explorer perspective opens.
A list of servers in the Remote Systems view displays.
4. Expand iSeries server, for example, s400a if not already expanded.

B Local

; @ﬁ» Libr ary list
. '}1 QSYS. ¥ib.prod-sys
-~ QsYs2.#ib.prod-sys
G-y, QHLPSYS *lib.prod-sys
=i QUSRSYS.Mib.prod-sys
[ ji* RSELABO1 i test-cur
= il RSELABO1. ¥lib test-usr
(-, YARLABOL *iib test-usr
(- iy, WFLABO1 . ¥iib.test-usr
SSLABOL. *lib. test-usr
-[#] DEMOR. *pagm.rpgle
-[#] DEMORES.*pam.rpale
-[E] GETDASOL. *pgm.rpale
-[#] GETDASOLY.*parm.rpgle
-[5] GETDATA *pgm.rpgle
-[&] GETDSSOLC. *pgm.chlle
-[#] READDTACQ *pam.rpale
: [#] WRTDTAC *pamrodle
Remaote Syfstems |Tearn

Use the same server that you have used to specify the reference fields in the
data structure.

5. Expand iSeries Objects if not already expanded.
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10.

11.
12.
13.
14.

Expand Library list if not already expanded.
If prompted, type your user ID and password.
Expand the library WSSLABxx.

You will see all objects in this library.

Expand the source file QRPGLESRC.

Ce Iy GETDASOLZ rpale

.y gETD GeTo
oMy GETD
= qQsvserT
- SALES.*F

Open With
Browse YWith »

‘i CODE Editor
- JH WASSCR. g pename I o

Scroll down to the source files in the expanded list.

Again you work with the same source members as before. Depending on
whether you specified that you wanted to work with a program, or a
procedure in a service program, you need to select a different member:

For the program call, right-click GETDATA member.
For the service program call, right-click GETDATAS member.
Select Open with > Remote Systems LPEX Editor on the pop-up menu.

Depending on your choice above, follow either the section named GETDATA
instructions or skip to the section named GETDATAS instructions.

Let’s switch to the Remote System Explorer perspective to begin.

GETDATA instructions
To update GETDATA instructions:

1.

4.
5.

Locate the RPG code you edited earlier.

It should be marked between the comments "Insert code here” and "Done with
inserting code”.

Find this line of code:

C EVAL FEEDBACK='CUS0001" + CUSTNOI
Change this line to:
C EVAL FEEDBACK="'CUS0001"

Now when the requested record is not found the value CUS0001 gets returned
without the customer number in the parameter Feedback.

Save the file.
Go to Exercise 7:4 Creating a *PGM object (for GETDATA) .

GETDATAS instructions
To update GETDATAS instructions:

1.

Locate the RPG code you edited earlier. It should be marked between the
comments "add your code after this statement” and "your code ends here”.

Locate the RPG code you edited earlier. It should be marked between the
comments "Insert code here” and "Done with inserting code”.

Find this line of code:

C EVAL FEEDBACK="'CUS0001' + CUSTNOI
Change this line to:
C EVAL FEEDBACK="CUS0001"

Now when the requested record is not found the value CUS0001 gets returned
without the customer number in the parameter Feedback.
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5. Save the file.
6. Go to Exercise 7:5 Creating a *SRVPGM object (for GETDATAS).

Exercise 7.4: Creating a *PGM object (for GETDATA)

Your code is complete, so let’s re-create the program.

To create the program:

4P Remote System Explorer - GETDATA - WebSphere Development Studio Client

File Edit Source Compile Mavigate Search Project Run ‘Window Help
IS -BR6([B]% -t s|AAM%
ﬁ M) Remote Systems v x ﬁ ( X l)

% &‘5’3' e & ':U:ED‘-P Row 28 Column
: —_———— ... 1...
] o) CUSTOMLL *fleF - ]

3 - CLSTOMLS HFie I b b feedos

1. Click the X in the Editor window title bar to close the member.
Be careful to not click the X on the workbench window title bar.
2. In the Remote Systems view, right-click GETDATA member in QRPGLESRC.

L, Il A
[IT- renote systcns NS x|
P P & & 5= Column 40 Rep
2 fjHu:% 2l 3 U Lo deneZons
P (] CUSTOMLL, .
¥ Browse With »
-] CUSTOML3, I feedback
. :B CUSTOMS1, @ Rename [~ fEnLry
<] cusTomsz, % Copy c..
] CusTOMS3, = c
0] cusTOMS4, “ Move [
@[3 EVFEVENT." g pelete e
[+ &y INVPRINT,* c
&) PRODDTL.*  Verify c-* . .
=[5 PRODINY. M Werify (Prompt) . ns-ﬁi-;-“'f'm he
#- 5 PRODLIST.Y  Compile CUSTNOI

=& PRODSHOW
=3 ProDUCT.?*

(] PRODUCTF
-y QUBLLESRC
&) E) QOOSSRC.*

Compile (Prompt)

B« CRTEMDRPG...

i 3 -
Hser Actions v (B CRTRPGMOD. ..

Add Ta iSeries Project...

Make Available OFfline ok Wwith Compile Command

El RPGLESRC o
@'% cETone  Compare With »
0y GETDAS  Properties

E iSeries Commands Log
54003 |

.y GETDATAS.rpgle
-0y GETDSSOL.rpgle

PR - - I.. ;

|

|
3. Click Compile (Prompt) > CRTBNDRPG on the pop-up menu.
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The Create Bound RPG Program (CRTBNDRPG) window opens:

&P Create Bound RPG Program (CRTBNDRPG) x|
Program: GETDATA =i MName =
Library: WSSLABOL B MName
Source file: QRPGLESRC hhd Mame, QRPGLESRC
Library: WSSLABOL hd Mame
Source member: GETDATA A | Name
Generation severity level: 10 0-20
Text 'description': *SRCMERTXT j Character value. ..
Default activation group: *YES A
Advanced Parameters
Compiler options: I - I &dd
*EVENTF emove(B) e
___———_-___-L Move down |
I™ Advanced (x) ™ Allparameters(V) ™ Keywords(Z)
CRTENDRPG PGM{WSSLABO1]GETDATA) SRCFILE('WSSLABD1 JQRPGLESRC) SRCMBR{GETDATA) OPTION(*EVENTF) ;I
DEGYIEW(*ALL)

OK I Restore defaults Cancel

4. In the Debugging views list, select *ALL
5. Click OK to start to compile.

After compile completes the error list view is shown, listing all compile errors.
You may see only information and warning messages which means your
compile was completed and the program object was created.

Cornmands Log

g v %

SRCMBR{GETDATA) OPTION(*EVENTF) DEGVIEW(™*ALL)

Program GETDATA placed in ibrary WSSLABO1, 00 highest severity, Created on 02{16/04 at
16:53:17.

Cause . ....: Program GETDATA was successfully created in library WSSLAEOL, The
highest message severity that resulted was 00, The program crestion date and time are
02/16/04 and 16:53:17.

Command INarmaI LI I

h
LI Prampt., .. | Ruri

Remioke System Details |Tasks |iSeries Table View |iSeries Commands Log | iSeties Error List

Click the iSeries Commands Log tab to check that the compile completed
successfully. This log shows the Remote System Explorer job messages.

Now you are ready to run your Web application.
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Go to the Exercise 7.6: Testing the new error page and skip Exercise 7.5:

Creating a service program (for GETDATAS). If you get a message that there

have been errors found in your program, go through the edit compile fix cycle.

Fixing errors
In the error list view check the errors:

1.

o g s wN

Double-click on the error.

This positions the cursor in the Edit window on the statement that is wrong.

Fix all errors.

Save the source member.

Go back to the Remote Systems view.

Right-click the member to run the CRTBNDRPG command.

Continue this cycle until you get a clean compile.

Exercise 7.5: Creating a *SRVPGM object (for GETDATAS)

Your coding is complete, so let’s create the service program.

To create the service program:

1.

3.

Click the X in the Editor window title bar to close the member.

4P Remote System Explorer - GETDATAS - WebSphere Development Studio Client

File Edit Source Compile Mavigate Search Project Run  ‘Window Help

| F-ERa|d]s - x-&- || A G-
ﬁ U Remote Systems N 65 o o o | H / GETORN ’)ﬁ

L] CUSTOML . *File.JF

@ L) ] CUSTOMLE. *File JF

Q LT FISTORS T #ila IE

nnenmn2

Be careful not to click the X on the workbench window title bar.

In the Remote Systems view, right-click the GETDATAS member in
QRPGLESRC.

£

MIF ot rvwmarEr e

o[ PRODLIST *file pf-
- PRODSHOW *file.r

+1-[F PRODUCT *file.pf-
-] PRODUCTIF *file I
-2y QCBLLESRC. *file.p
&)-Ely QDDSSRC *file.pf-
=)-E) QRPGLESRC *file.£

Yetify (Prompt)
Compile »

d v P CRTENDRPG...
User Actions »

R

Cornpile {Prompt)

B« CRTRPGMOD...

#dd To iSeries Project.,..

Make Available Offline T work with Compile Commanc

- GETDASCL.rpg
Compare Yith 4
-y GETDASOLZ.rp F
[y GETDATA.rpgle Properties
IR CE TDATAS. Fpgle _l

¢ @ GETDSSOL.rpale
#-F QSVYIPRT.*file,pf-dta
-3 SALES.*file.pf-dta

[N wassCR Hile.sav |

Click Compile (Prompt) > CRTRPGMOD on the pop-up menu.

Eﬁ iSeries Commands Log
s400a |
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The Create RPG Module (CRTRPGMOD) window opens:

4P Create RPG Module (CRTRPGMOD) _ x|
Module: GETDATAS =] Mame =
Library: WSSLABO1 = Name
Source file: QRPGLESRC Jlad Mame, QRPGLESRC
Library: WSSLABOD1 Jlad Name
Source member: GETDATAS v | Mame
Generation severity level: 10 0-20
Text 'description': *SRCMBRTXT ‘:] Character value...
Advanced Parameters
Compiler options: I - | Add I
*EVENTF Bemove
N
Debugging views: FaLL
[~ Advanced () [ all parameters(y) [~ Keywords(Z)
CRTRPGMOD MODULE(WSSLABOL /GETDATAS) SRCFILE(WSSLABDL /QRPGLESRC) SRCMBR{GETDATAS) OPTION{*EVENTF) ;I
DEGYIEW(*ALL)

oK | Restore defauts cancel |

I - |

4. In the Debugging views list, select *ALL.
5. Click OK to submit the command.
After compile completes the error list view is shown, listing all compile errors.

If you see only information and warning messages that means your compile
was completed and the program module was created.

d v x

DEGVIEW{*ALL) &
Module GETDATAS placed in library WSSLABOL. 10 highest severity, Created on
02/16/04 at 17:00:58,

Cause . ....: Module GETDATAS was successfully created in library

WSSLABOL, The highest message sevetity that resulted was 10, The module

creation date and time are 02/16/04 and 17:00:58,

3

Command INarmd j I ﬂ Prom

Remate System De... | Tasks |iSeries Table Yiew |i5eries Commands ... |iSeries Error List

Click the iSeries Commands Log tab to check that the compile was successful.
This log shows the Remote System Explorer job messages.

Now you are ready to create service program.
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Go to the section Creating a service program. If you get a message that there
have been errors found in your program, go through the edit compile fix cycle.

Fixing errors
In the error list view check the errors:
1. Double-click on the error.
This positions the cursor in the Edit window on the statement that is wrong .
Fix all errors.
Save your source member.
Go back to the Remote Systems view.
Right-click the member to run the CRTRPGMOD command.

Continue this cycle until you get a clean compile then proceed down to the
next step.

S e

Creating a service program

To create a service program:

1. In the Remote Systems view, find the GETDATAS module in library
WSSLABxx.

+-1dZ) ORDENTR. *srvpgm.rpgle
[ 4] GETDATA.*module

-5 A

-4 GETD:  GoTo 3
B 4] GETDS —
@ ﬂ SLTPA Shaw in Table

R e 1) o
w [ Ivme o Rename

[ mvms EZ) Copy
- {2 YRPGH B Paste
Remote Systems |Tearn

+ Move

[ Properties % Delete
Property I Value

Attribute RPGLE Frogram...

Mame GETDATE Update > Service Program...

Mumber of chi,.. 3 Change... I
Tip: If you don’t see the module, select the library, right-click and then select
Refresh.

2. Right-click the module.
3. Click Create > Service Program on the pop-up menu.
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The Create Service Program (CRTSRVPGM) window opens:

4P Create Service Program (CRTSRYPGM)

x|
Service program: GETDATAS MName =
Library: WSSLABD1 -1 Name
Maodule: | Name, generic*
Library: "I Add | hame
WSSLABDL/GETDATAS = I
LETNOVE
[rlave up I
Export: ( 2 |
Export source file: QSRYSRC b Mame, QSRYSRC
Library: *LIBL ¥ Mame
Export source member: *SRYPGM "I MName
Text ‘description’: FELANK :] Character valuz
I Advanced (L) [~ all Parameters I~ Keywords
CRTSRYPGM SRYPGM{WSSLABOL /GETDATAS) MODULE('WSSLABO1 /GETDATAS) EXPORT(*ALL) ;I

OK I Restore defaults Cancel

4. In the Export list, select *ALL

5. Click OK.

6. Check the iSeries Commands log to see that the service program was created.

E'g iSeries Commands Log

4 v %

s400a |

EXPORT(*ALL)

CRTSRYPGM SRYPGM(WSSLABO1/GETDATAS) MODULE(WSSLABOD1 JGETDATAS)

Service program GETDATAS created in library WSSLABOL .

Cause ... ..: Service program GETDATAS was successfully created in library
WSSLABOL, Recovery ... @

Service program crestion was successful,

5

Command |Mormal j I

j Prom

Remote System De... | Tasks |iSeries Table Yiew |iSeries Commands ... | iSeries Errar List

7. Click the iSeries Commands Log tab at the bottom of the workbench.

You should see a message that the service program was created.
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Exercise 7.6: Testing the new error page

Now that the flow control is in place, if you enter a wrong customer number,
Ihttp:,l',l'lclcahclst:‘B'EIBIJ,l'MntHJxx,l'i'uuiy.isp j Q<= @ @“? = | D
=

Customer Inquiry

Enter customer number: 9999 _
Reset

Done

you will get the error page instead of a message.

e

I http: fflocalhast ;9080 wintlabix fcustInguiry.do j =20 @“? = | D
Sorry, there is no record for that customer number,
Please check the number and try agan

Done

Now follow the instructions below to run the modified project on the WebSphere
Test Environment to see the result of adding flow control to your Web application.

The server should still be running from the last time you ran the Web application.

Every time you make a change to the Web application, you need to restart the
server to pick up the changes.
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To restart the server:

@ Stop
& Disconnect
72 Publish

Switch Configuration 3

Restart Project >

thy Add and remave projects...

Run universal test clisnt —
Restart universal test client

Fun administrative console .?7 ® 7 Eja ®

Server

[ Greate tables and data sources

i WebSphere wS.0 Test Ervironmen

1. In the Web Perspective, click the Servers tab to open the Servers view.

2. Select the server instance. Right-click and click Restart on the pop-up menu.
The server instance should restart.

3. In the Web perspective Project Navigator locate the WebContent folder, and

Go To 3
Open
Open With 3

. 1= Copy
€y wdtstobr,  Paste
- [E) wintlabxx.  Delete...

| E+--HF Libraries Mowe,..
Project Navigator | Gallery Rename. ..

Attributes Import...
Expott...

Add Bookmark. ..

No attributes are availabl

Rebuild Project
Refresh

Run validation
uﬂ Debug on Server...

- i Run on Server...

A1 Profile on Server. ..

4. Click Run on Server on the pop-up menu.
5. Enter a wrong customer number, for example 9999.
6. Click Submit.

The error page opens.

Recap
Congratulations! You have completed Module 7: Adding an error page. You should
now understand how to:
* Use page designer to add a new error page.
* Use the Web interaction wizard to add the error page.

* Use the RSE perspective to modify the program or service program to call the
error page.

* Create a program or service program object.
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Now that you have added an error page to your Web application to handle
incorrect customer numbers, you can continue to Module 8: Enhancing the
customer inquiry input page using Web tools.
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Chapter 8. Module 8: Enhancing the input page using Web
tools

In this module, you will learn how to use the Web tools in the Development
Studio Client workbench to update the input page of your customer inquiry Web
application. The input page named inquiry.jsp is one of the files created by the
Interaction wizard. This page is very plain. You will learn how to use Page
Designer and some related Web tools in the workbench to add some color to the
input page, as well as add some pictures to make it more interesting Web page.

In order to enhance the customer inquiry input page, there are several steps you
will need to learn about and follow:

* Using Page Designer

* Using Page Designer components to create a more attractive browser interface
* Adding a style sheet to the page

* Adding a heading that moves

¢ Adding a graphic from the sample gallery

* Creating a Logo with a Web design tool

¢ Testing this new input page

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Exercise 8.1: Opening Page Designer

* Exercise 8.2: Working with page properties

* Exercise 8.3: Linking a cascading style sheet to the Web page
* Exercise 8.4: Designing and adding a logo

* Exercise 8.5: Adding a headingl tag to the page

* Exercise 8.6: Adding a picture to the page

* Exercise 8.7: Adding moving text to the page

* Exercise 8.8: Changing the text color in Page Designer

Exercise 8.1: Opening Page Designer

The first step is to locate the inquiry;jsp file and to start Page Designer. In Page
Designer you will link the page to a cascading style sheet that comes as a sample
with the workbench.

To open the Web perspective:
1. In the workbench, open the Web perspective.
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You should now have the Project Navigator view in your workbench
environment.

a o (£ }t: .=§='
- -2 WebContent -
-3 META-INF
;_| (= theme
B- YWEB-INF
_/ changenorrusaed icn
_,, rror.js Mew 3
'5'—; Go To >
%5 oo IR
oo ‘Jd messag  Open With 4
-_{ Record
_j result. . Copy
L&y wdtdor  Paste
“[Z] wintlab  Delete...
- Libraries Move...

Project Mavigator | Gall  Rename...

2. Expand the wintlabxx Web project if not already.
3. Expand the WebContent folder if not already.
4. Right-click inquiry.jsp and click Open on the pop-up menu.

3. ingg x |
Inquiry.45p - Untkled ]~ | BobvY - | Standard ~
: =
Customer Inqunry T
’%mqwry label E-nter customer number f :
E Feinguiry button, subrmit | %einguiry.button, resek | :
H

———
@esign)Saurce |Preview

The Page Designer appears in the upper right pane of the workbench and
shows the inquiry.jsp page as the Web Interaction wizard created it.

Make sure that you are on the Design page in Page Designer.
5. Click the Design tab.

Exercise 8.2: Working with page properties

Next you move the form down.

To work with page properties:

90 ILE RPG e-business application



1. Click underneath the heading Customer Inquiry.

T =]

inquiry.jsp - Untitled * El -~ FORM ~ | Standard ~
C UsuuUIIIc llll.ll.llly oy -

RS
&

E-
£ £

=
£

}»5\\b\\}\;}\.\b&\)\\b&\}\\&!\&\.\)&\b\\b
< <&

%%inquiry.labl:l_Exltcr_customa’_mlmhcr I

4

e Y At E L s

-

Design | Source |Preview

2. Press Enter number of times as shown above.

3. To change the page properties, right-click the background of the inquiry.jsp
page in Page Designer.

of~ Cut
Copy
E Paste

8 Delete

Save

Insert »
J5P L3
Insert Input Fields »

Aktributes
[E Quick Edit
Layout Mode 3

—0| P Eo Line

4. Click Page Properties on the pop-up menu.
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The Page Properties window opens.

4P Page Properties x|

Page Information | Meta Info | 5P Tags |

Page title: I Custamer Ingquiry

BaseURL: |

Default target: |

Encoding:

Lel L]

o | cancel [

This window allows you to change some of the page properties.

For example you could change the title. When this page is shown in a browser,
the Window title bar of the browser will display Customer Inquiry.

5. Close the Page Properties dialog.

Exercise 8.3: Linking a cascading style sheet to the Web page

Now you will add a style to the Web page. You can use a style that is used in your
company or you can use one of the sample style sheets that are provided in
Development Studio Client.
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To link a style sheet to a Web page:

#-{8) Image
[+ Ay Webart

@

rofect Navigatol [Galery Dotruts Explorer

inquiry. jsp - Customer Inquiry *

N USLUIIIET 'I'llq

EN
&
[

E]
£

E3
S

=
LS

\\&\\5\%\\5\.\5\\&%\5\\3\\5\.\5\\&\\5
= =
“ ©

Z%mouiry.label Enter customer number l_

3
U

/-

Ltvle Sheet Files (*.c55)

7 f

creamsodal. . | denim001.cs.. | drywind001....

=

Design |Source |Preview

i servers

SErver I Status

Bwebsphere v5.0 Test Envirconment 3% Started

|

Quick Edit | Tasks | Colors IServers ‘ Console

1. Click the Gallery tab, if the Gallery view isn’t already displayed.

2. Click the Style Sheet icon in the Gallery list.

3. Click the Thumbnails tab in the bottom view in the workbench.
You should see thumbnail icons of all the styles available as shown above.

4. In the thumbnail view, scroll down to the bottom, until you see style sheet
denim001.css in the list, or select a style sheet that you like best.

o o

Designer window.

b3
The cursor will change from this shape o , to this shape*#] . When the
latter cursor shape appears in the Page Designer window then, let go of the

mouse left button.

Click the thumbnail picture of denim001.css.
Hold the left mouse button down and drag the mouse cursor to the Page

After a short while the Style sheet properties will be applied.

7. Click the Preview tab.
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8.

You will see the colors in the page have changed to the style sheet definitions
as shown below:

B ]

inquiry.jsp - Customer Inquiry * & G

| Customer Inquiry |

%inquiry label_Enter_customer_number :

%inquiry. button. submit I %inquiry. button.reset |

hd

Design (Source Preview |

Click the Design tab to get back to the Design page.

Exercise 8.4: Designing and adding a logo
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Now that you have the overall Web page look specified you will use the WebArt
Designer to create a Logo that you then will add to this page.

To start the WebArt Designer:

4P Web - inquiry.jsp - WebSphere Development Studio Client Advanced Edition for iSeries
File Edit Tookar Pade | Tools

vigate Search Project Run ClearCase  ‘Window Help

IS-B8 &2

Launch External Web Browser Dk] s I I S |J B 7 U A a4 F3E

[2® -] 0] l#mﬁﬂhgﬁﬁl!
g 51} Gallery X i I

- Ima inquiry.jsp - Customer Inquiry *
2 g,i::abg:rt Incl-lvm: Cust Inquiry
1.

Make sure the Page Designer is in focus.
Click Tools > WebArt Designer in the workbench menu.
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The WebArt designer opens as shown below.

@ Untitled - WebSphere Studio WebArt Designer =10} x|
Fil= Edit Wiew Object Tools Help
| usEB|sfaRxE |7 oz «e(e» e
W@y
a X nl:l - Al————Aa X
% Webdrt ﬁ Galcwl i
D 2 = |7
Button Rollover  Shapes AN I R
Test AD-
~ & &~ o
4 EA
e e B e 0 [
| §|| 4%
biewme) |
Sﬁp n@: Za < | Ll;, =
For Help, press the [F1] key. | [ 4

The WebArt designer shows the Template Gallery on the left, where you find
samples of logos, buttons, rollovers, images and more. The big white area in
middle of the dialog is the canvas that is used to work with objects that you
want to create or change. Now you will create a logo from scratch.

You could also select one from the template gallery as the base for your own
logo.

Click the Create Logo button above the canvas or click Object > Create Logo.
The Logo Wizard opens:

Logo Wizard (Specify Text - 1/4) ﬁl

Y a

wilabwx :I .

;I f A

—Fant

Font name:\__ | Comic Sans MS j

Font size: ' EI

Line I D= Character I :

spacing: =% spacing: e
—Style————————— ~Alignment

¥ Bald O Left

I i

[ Stikethrough <" Right

[~ Underline _Diection

W Antislies I Vertical

< Back I Nest > I Cancel Help
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9.

10.

11.

In the Text field, type your company name and in the next line in the Text
field, type wintlabxx.

In the Font name list, select Comic Sans MS.
In the Font size list, select 46.
Under Alignment, select the Center radio button.

Notice in the upper right corner of the dialog, a sample of the logo as
specified at the moment is being displayed.

Click Next to go to the next page of the wizard.
The Select Color page opens:

Logo Wizard {Select Color - 2/4) EI

autumn

< Back I Next > I Cancel I Help I

Select the gradation type button; the middle one of the three type push
buttons.

Tip: The other buttons select color types: solid and textured.

Select beer from the colors available, or any other color you like best, just
scroll through the list to find a gradation you like.

Tip: You can change the colors by clicking the Others button on this dialog
and create you own gradation.

Click Next to go to the next page of the wizard.
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The Select Outline page opens:

Logo Wizard {Select Dutline - 3/4) ﬁl

~ Options

Edge width — ]

Edge color; _l

Transparency: e I []3: %

Bulge for edge: ’E il

< Back I Next > I Cancel I Help I

12. Select the Seal outline from the list, or any outline you like best.
13. Click Next.
The Select Text Effect page opens:

Logo Wizard {Select Text Effect - 4/4) : ﬂ

— Options

Embossment
strength:

Embossment
direction:

< Back I Finish I Cancel I Help I

14. Select the Emboss text effect, or one that you like best.
15. Click Finish.
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You return to the WebArt designer window:

-
o
w [l -
Av@-
< &K~
& A
4
A%
SR
ZQ

._
]

Resize the logo object on the canvas:
16. Click the logo object to select it.

17. Move the cursor to the rectangle at the right bottom corner of the object;
watch the cursor changing shape.

18. Drag the rectangle up and to the left so the object becomes smaller.

Now you need to save this object. First save it as a WebArt object. This allows you
later on to work with the object again in WebArt designer, but you can’t use that
format for your Web page.

To save this object:
1. Click File > Save on the WebArt Designer menu.
The Save Canvas As window opens:

Save Canvas As 21 x|
Save in: ] |7 WebContent EI & B o E-
CIMETA-INF
Ctheme
) WEB-INF
File name: Imylagn Save
Save as type: | wetdt files (*mif) | Cancel |

I Include Carvas
VA

Make sure the directory is pointing to the WebContent directory in the
workspace where your Web project is located.

2. In the File name field, type mylogo.

3. Click Save.
Now you need to save the object in a form that can be displayed on a Web
page.

4. Click File > Save wizard for Web from the WebArt Designer menu.
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The Save Wizard opens:

Save Wizard (Specify Objects) - 1/3 ﬁl

Specify the objects you want to save.
ave the selected objects

" Specify the objects Specify... I

¢ Back Nest > Cancel | Help

5. Click the Save the selected object radio button.
6. Click Next.
The Select File Format page opens:

Save Wizard (Select File Format) - 2/3 El

Select a format for the image file.

IF

 JPEG

" PNG

This format can handle only 258 colors, By saving an image as a
GIF file, you can reduce its file size. This format is suitable for
images that do nat require many colors, such as line drawings of
araphs.

“Y'ou can make pait of an GIF image transparent.

This format is in general use on the Intemet because of its small file
size and inconspicuous image degradation. This format is suitable
for full-color images, such as photos taken with a digital camera.
ou cannot make a part of a JPEG image transparert.

This format maintains the quality of an image, but the file size
becomes larger than that of a JPEG. This format is suitable for
full-color images whose quality is important, such as computer
graphics.

Wou can make a pait of a PNG image tiansparent; however, only a
few browsers can handle it correctly.

< Back Newt > Cancel Help
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7. Click the GIF radio button.
8. Click Next.
The GIF Format page opens:

Save Wizard (GIF Format) - 3/3 ‘ x|
[Driginal image] [Image to be saved]
IBM 1B

'urfxx - 208

File size before: 18380 bytes
File size after: 3836 bytes
— Palette — Properties
€ Use the palette for the current file W Tiansparent ﬁ]
% Use the optimized palette I~ Interlace

. l 256 colors ¥ I
Colors: colors ~ Backaround color
Dither  |'es S I_ ’
Color of the Carvas ¥

< Back Finish Cancel Help

9. Click Finish.
The Save As window opens:

: 21 x
Save in: l [ WebContent EI & Bk E-
CIMETA-INF
)theme
|C5) WEEB-INF
»] denimooabu.oif
File name: |my|ogd Save
Save as type: IGIF files [*.aif) j Cancel I
Vi

Make sure the directory is pointing to the WebContent directory in the
workspace where your Web project is located.

10. In the File name field, type mylogo.
11. Click Save.

Close the WebArt designer.
12. Select File > Exit from the menu.

You return to the workbench in the Web perspective and see the Project
Navigator.
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13. Make sure you switch from the Gallery view to the Project Navigator.

14. Expand the wintlabxx Web project if not already.
15. Expand the WebContent folder if not already.

16.
17.

18.
19.
20.
21.

& Project Nz S 2 &

- [#-{= META-INF

. @ theme

. [z WEB-INF

P changePassword.jsp
8] denim001.css
- [¥ denimo03bu.gif
@ error.jsp
- B} inquiry.jsp
- logon.jsp
. ﬁu Messages. js

- [# mylogo.mif

@ RecordMotFound.jsp
-l result.jsp

€4 wdt400br js

Project Navigator | Gallery | Struts Explorer

The mylogo.gif file should appear in the list as shown below. If it doesn’t

appear, the list might need to be refreshed.
Right-click the Web Project wintlabxx folder icon.

Select Refresh.

Hopefully you can see the file now in the WebContent folder, if not, go to

Windows Explorer and search for the mylogo.gif on your hard drive. Move it
to the WebContent folder in the Development Studio Client workspace. If you
didn’t use the default location as shown above, do a search for the workspace
and the wintlabxx directory in it. Move the mylogo.gif file into the
WebContent sub directory under the wintlabxx directory. Now you can take
the logo and put it on your Web page that is still open in Page Designer. If

Page Designer has been closed just open the inquiry,jsp file. Make sure your
are on the Design page, not the Preview page In the Project Navigator view:

Select the mylogo.gif file.

Hold the left mouse button down.

Drag the file to the upper left side in the Page Designer window.

Let the mouse button go.

The logo is placed on the Design page:

changePassword.jsp
-8) denim001.css
#) denim003bu.gif
-3 error.jsp
@, inquiry.jsp
legan.jsp
Pl e

gif
X mif

@, RecordiotFound.jsp
Bl result.isp he

;\\m&l\:\n\m
0
-

| mylogo,

%5 Project Navigator v X W b4 |
G oo A S inquiry.jsp - Customer Inguiry *
B META-INF -

| #{= theme

@3 WEB-INF

78R

E
£

Project Mavigator ]Galery | Struts Explorer

Design | Source | Preview
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Exercise 8.5: Adding a heading 1 tag to the page

Now you want to insert a nice heading below the logo.

To add a heading 1 tag;:
1. Position the cursor just below the Logo at the first BR tag.

4P Web - inquiry.jsn - WebSphere Development Studio Client Advanced Edition for iSeries
File Edit Toold

bP Format Table Frame Page Tools Navigate Search Project Rur

curkQ P B 40 B0 48 i o
| ImageFile »
g %5 Project Na Backaround Image File »
% & &) Background Music >
=R wet e e,
’E g M Fre= Layvout Table
gl =D
=9 P
[ Paragraph Mormal Chr+0
P T— - —
i @, 3
), [ Table... Ctrl+T Cirh2
: B — Horizontal Rule Heading 3 Cirl+3
i % P 3 Inout Field N Heading 4 Chrl+4
@ et Heading 5 Ctrl+5
LBl D Script Heading & Cirl+6
; % 3] iseries Web Components... Address
sl Block Quotation
P % [ Layout Box Preformatted

2. Click Insert from the workbench menu.

3. Click Paragraph > Heading 1 from the pop-up menu.
A frame appears that allows you to enter text.

4. Enter your company name.

o Y

inquiry.jsp - Customer Inguiry * El -~ | FORM ~ | Standard ~
Iﬂ’n’h IUII.DD..I

-

Customer Inquiry ¢

=fr

Jabresed

:@ Labor@

Design | Source |Preview

q

A SNAREN SRS

4

Now you want to use one of the sample pictures that comes with Development
Studio Client and place this picture on the page.

Exercise 8.6: Adding a picture to the page
To add a picture to the page:
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1. In the Project Navigator, click the Gallery tab.

b web - inquiry.jsp - WebSphere Development Studio Client Advanced Edition for iSeries e =10 x|
File Edt Toclbar Insert J5P Format Table Frame Page Tools Navigate Search Project Run Cbm:ase Window Help

|5 -BR & | E%|=]8-]6 |
|omCeN®APAD A BLTHHEmMO || %- |% @ -
| =

| ¥ 3
& Galery x || B sinquryisp X |
= Image 2 | inquiry. jsp - Customer Inquiry * Fl~| me -
(23 Banner
(23 Bullet .
& Buton Customer Inquiry ¢+
oo
(3 Hustration
L T
(3 Photo
(3 Theme
-3 Title
i 3 Wallpaper
w & webart
= g1 Multimedia

W eldag

Laboratory

Design ISm.rue |Prev19w

-
4 ¥ -

Quick Edit | Tasks | Colors | Servers | Console | Palette |5 4

2. Expand the Image folder.
3. Select the Illustration folder.

4. On the Design page beside the Gallery view, select one of the sample
illustrations, for example, use file u013cut.gif.

5. Drag the picture onto the Design page beside the logo.
The Design page now contains a picture. Click thePreview tab.

inquiry. jsp - Customer Inquiry * & &
| CustomerInquiry |~
1B
wfxx

Laboratory

%
inquiry label_Enter_customer_number

Design |Snur|:

You are almost done. Next you add moving text to the page.
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Exercise 8.7: Adding moving text to the page

Now you add moving text to the page:
1. Position the cursor in the Design page underneath the picture.
2. Click Insert from the workbench menu.
3. Click Paragraph > Heading 3 on the pop-up menu.

E x|

inquiry . jsp - Customer Inguiry * El -~ | FORM = | Standard ~

Customer Inquiry s¢

-

1BM Laboratory

=
L

=
=

R e L LE RS LR LRSS S L

AR

q

Design | Source |Preview

4. Leave the cursor positioned inside the heading 3 frame.
5. Click Insert from the workbench menu.

=10/x|

P Format Table Frame Page Tools Navigate Search Project Run C]ea(ase Window Help

# Web - inquiry.jsn - WFhSphFY“ Development Studio Client Advanced Edition for iSeries

e FREIF BT
[ w0 . ’ CHTEELE] LS

?
1
;
g

28 Image W Free Layout Table | H3 v | Standerd -

i}
’%I D Bah i : -
@

3 Bulk =Y Text cel |r Inqulry 88
o ——————— . ) R
(3 Ieor Paragraph 2
3 s
Ca Line [ Table... kT
3 Pho — Horizonkal Ruie
3 The
(2 Title  Form and Input Fislds »
3 wal -
er Webart 5 Seript
: "\J"m iSeries Web Companents. .. 1) Java Applet...

i

3 Thumbralls —joe ek .. Ciri+Enter Object... ———
I[rnaoeFIes("‘.u_ Special Characters... . 4

AR

Non-breaking Space Chrl+-Shift+Space :

Fe. e () :

Keyword... SPAN with Style. . P>
Y Date and Tie... ERLY

- r Comments. .. Bk - 8 4 x
e HTML Source... i -
4 =3 Palette |5t 4/
Site 4

wiirkiabcc Wb CormermmmemryTyser

6. Click Others > Marquee on the pop-up menu
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The Insert Marquee window opens:

lﬁa Insert Marquee il

Text:

el
Please enter customer nurber and press Submit button to start application
—Behavior wm-g

Morrenmen ' as Repetition:
Direction:  [(Autc) | e

—Display speed  Size

Delay time: I Width: ] Ipbcels j
Scroll amount: I Height: l Ipb(els ﬂ

[~ Use true speed

~Color [

Background color: ;I il

g oK E] Cancel |

7. Enter into the Text field: Please enter customer number and press Submit
button to start application.

8. Select Slide from the Movement list.
9. Select Finite from the Repetition list.
10. Type 1 in the Countlist.

The two last selections just avoid the text sliding in forever and not standing
still. If you want more movement on the page, you can change these settings.

11. Select Lime in the Background color list. Click OK.
12. Click OK again.
The Design page should look like:

To save some space, you can remove some of the line break tags.
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13. Position the cursor on the BR tag.

inquiry . jsp - Customer Inguiry *

Customer Inquiry =

EIBM Laboratory

O

E%inqujiy.labl:l_&lter_custumm’_mlmher i Find

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Design ISnche | Preview

14. Press the Delete key until the entry field and push buttons appear on your
page.
Next you view the page as it would appear in a browser.

15. Click the Preview tab at the bottom of the Design page.
You will notice that your heading 3 text is sliding in:

inquiry.jsp - Customer Inquiry *

Laboratory

%inquiry label_Enter_customer_number m

%inguiry. button. submit | Yinguiry. button.reset I

NS

i)

Design | Source [Praview ]
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Exercise 8.8: Changing the text color

Sometimes you want to change the text color. There is an easy way to apply
another color to certain areas of text. To do that you return to the Design page.

To change the text color:
1. Click the Design tab.

@*inq.liry.jsp X‘
inquiry.jsp - Customer Inquiry * E] ~ | | Standard -

[ #ocffee P mcdone

Set as Table Backaround Color 4

g ——— of Layout Box
Set as Text Color

Quick Edit ﬂasks@d;or})ewers | Console

2. Select the company text (IBM) you want to change color on, by swiping the
text area with the mouse cursor.

Below the Page Designer window there are several tabs.
Select the Colors tab.
Select a color from the Color palette.

Click Text color from the Color menu.

BRI

Click Set as Text Color on the pop-up menu.

You are done; now the selected text will be displayed with the color you
selected for it.

7. Select the Preview tab to view your completed page.
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8.

10.
11.
12.
13.

Save the file inquiry,jsp.

@ *ingl X

inquiry jsp - Customer Inguiry *

. Customer Inqui
S A
IBM Laboratory |

IBM Laboratory

%inquiry label_Enter_customer_number n

Yeinguiry. button. submit I %inguiry. button. reset I

Design | Source Eevlew ?

Exit Page Designer.

In the Project Navigator expand the wintlabxx folder if not already.

Expand the WebContent folder.

Right-click inquiry.jsp.

Click Run on server on the pop-up menu.

Your new designed input page opens and you can run your Web application.

R ]

I:ﬁp:ﬁlocahust:QUEIU,l‘whtIabxx,l'hq.liry.isp ;I °| S @ q,‘:i = | .

-

Laboratory

Enter customer number: u o

Done . [
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Recap

Congratulations! You have completed Module 8: Enhancing the input page using
Web tools. You should know understand:

¢ The purpose of Page Designer.

* How to open Page Designer.

* How to add a style sheet to a Web page.

* How to work with Web page properties.

* How to design and add a logo to a Web page
* How to add a heading 1 tag to a Web page

* How to add a picture to a Web page.

* How to create a logo with WebArt designer.

* How to add moving text to a Web page.

* How to change the text color in a Web page.

As you can see, the intent of the iSeries extensions to the Web Development Tools
is to enable you to be immediately productive creating Web user interfaces on top
of RPG business logic, leveraging your existing skills and potentially even existing
code, and delaying the need to learn HTML, JavaScript " and Java. These
extensions include a palette of iSeries-unique JSP custom tags within the Web Page
Designer, which offer attributes for formatting, validation and field referencing that
you are accustomed to from your green screen development. These attributes
include data type, length, decimals, formatting and validation. From these
attributes, client-side JavaScript is generated. These palette parts defer the need to
learn HTML and JavaScript.

The Web tools extensions also include a Web Interaction wizard, that given the
signature information for an iSeries executable or entry point, will generate not
only the Java bean wrapper to call it, but also a Struts action that uses it, and
optionally input and output JavaServer Pages and form beans to prompt for the
input parameters and display the output parameters.

A Web application that uses RPG for business logic, can be created by creating and
stringing together Web interactions, where the output page from one interaction is
the input page to the next interaction. When the JSPs are created first, the Web
Interaction wizard allows mapping of input fields to input parameters and output
fields to output parameters. This interaction wizard defers the need to learn Java,
JSPs and Servlets, especially if combined with the Web Site Designer for creating
page templates, preferably by someone else skilled in Web design.
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Appendix. Notices

Note to U.S. Government Users Restricted Rights — Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM Canada Ltd. Laboratory
8200 Warden Avenue
Markham, Ontario

Canada

L6G 1C7

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1992, 2004. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.
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However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks

IBM

iSeries
0S/400
RPG/400
VisualAge
WebSphere

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows
NT®, Win32, Win32s and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX® is a registered trademark of The Open Group.

Other company, product, and service names may be trademarks or service marks
of others.
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